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Definitions of Identifiers

A ATTENTION : Identifies information that requires special attention.

@E% TIP: Identifies advice or hints for the user.
L
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1 Overview

Released in 2015, NovaStudio plus is powerful software, professionally designed for the

LED display media play application. Features of NovaStudio plus are as follow.
< Capable of multiple LED displays application

NovaStudio plus is capable of feeding media data (video/text) for multiple LED displays at
the same time with each of the these LED displays has its own play program and mapping

area (area for showing the media data)
< Remote display screen management

Operate the remote control and release playing programs to the display screen via

NovaStudio plus on a computer;

< Multi-date multi-period scheduling function

Play different content at different date and time segment ;
< Multiple page

A play segment can have multiple pages on which the layouts of the windows for media
display are different from each other. Refer to 2.1 Play Program Structure for the concept

of the term page.
<> Pages with multiple windows

Each page of a play segment can have multiple windows for media display. The positions
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and sizes of these windows can be set individually.

< Rich in the types of media supported

Media types supported include videos, audios, pictures, Flashes, text, analog clocks, digital
clocks, countdown timers, weather info, video devices, web pages, humiture, streaming

media , RSS, digital count timer, vista clock...

< Complete media properties setting

The media properties can be set include the background color, background picture,
transparency, volume of sound, display scale, animation for entrance/exit(in/out),

animation speed and color, effects, font, style, transparency for texts.

< Rich in effects for text/picture displaying

Altogether, there are over 40 different effects for text/pictures displaying. With special data

processing design, they are efficient and smooth.

< Stuck prevention

Due to problems from decoders or computers, video could be stuck during being played.
Stuck prevention function is designed for NovaStudio plus to escape from that kind of
situation. NovaStuio2012 can recover by itself and begin to play next media when the video

or sound being played is suck for certain time (normally 10 seconds).

< Fluently switching between pages

No black screen will appear during switching between two program pages with different
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layouts;

< The effect of transparency

Media sources of the types of clock, countdown timer, text, office file, weather info can be

shown with transparency effect.

< Web page supported

Real-time display of designated area of the web page;

Quick preview function

Do quick preview of play program in different rate.

< Timing and cycle inserted segment

Play program may include the timing and cycle inserted segments, which can play alone or

play with the current common segment;

< Synchronal playing

Realize the synchronal playing of multiple remote display screens;

< PPT files supported

< Emergency inserted play and notification function

< Security measure — computer locking

NovaStudio plus can lock the computer for security. The key board and the mouse will not

work after locking.
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<{ Self-recover from severe error

< Software auto run and media play auto start

< High efficient video format support with embedded decoder

The embedded decoder is capable of long term working. And the decoder can be updated

for better performance.

< Easy log management

Play log can be recorded, check, statistic and exported to Microsoft Excel files, which makes

log management become very easy and flexible.

< Play program backup

By creating a copy of the play program files, together with all the media files involved and

storing the copy in the hard disk, play program backup can be achieved for security.

< USB disk plug and play function

Monitoring the insertion of the USB disk, and automatically play the play program file on

USB disk.

< Programs exported to USB flash disk; Bind MAC address

Programs exported to USB flash disk can only be safely and reliably plugged and played on

computers with the MAC address being bound.
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1.1 Functions

< Includes time frame priority program and page priority program.

< Setting of screen count, location and size.

< Play program creation, opening, saving, saving as, backup and application.

< Play, pause and stop of play program.

< Add, delete and set properties of common segment.

< Add, delete and set properties of inserted segment.

< Add, delete, edit, move up or move down of the pages, windows and media sources of
a play program.

< Pages properties setting. The properties include the background color, background
picture, showing modes (show the picture periodically, according to time duration or
by times), displaying scale, transparency, color and effects for text and so on.

<~ Detailed dispatching time can be checked as per time or window;

< Properties setting and previewing of media sources.

<- Drag previewing of videos and flash files.

< Super impose transparent words on videos and flashes;

<> Play streaming media files;

< Display temperature and humidity.
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< Media sources finding, moving and properties setting for all.

< Quick preview or normal preview of page or segment.

< View the scheduling information of play program.

< Opening of the newly accessed play program files.

< NovaStudio plus auto run after the computer startup.

< Set the play program to be launched when the software starts.

< Play notification.

< Play emergency inserted content.

< Backstage media playing.

<$ Restart on time.

< Set the days for play log storage.

<~ Delete the out of date play log files automatically.

< View, statistic and export to Excel file of play log.

< Computer locking

< Convert PPT files to pictures.

< Tool management.

< Multiple languages supported.
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< USB export and instant plug and play;

< Remote display screen management: send file, video playing scheme, order, time tick,

screenshot, remote inserted play and notice;

< Media synchronization broadcast;

1.2 Run Environment

< Tests passed on the OSs of Windows XP \ Windows2000\ Windows7(32-bit)\

Windows7(64-bit)\ Windows8(32-bit);

< CPU Frequency >= 1.6GHZ , Host Memory >= 1G, Graphic Card Memory >512M

TIP:

With a computer not match the requirements, NovaStudio plus may work

:,GH abnormally. The problems could be shift playing or low loading speed.

The shown text could be jittering if the graphic card memory is less than

512M.

< To open and show .doc or excel files, Microsoft Office should be installed first.

TIP:

P

)

o
.doc or excel files could not be loaded if Microsoft Office is not installed.

< To open and show flash files, Flash OCX should be installed first.
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< To open and play video files, it is required that

» DirectX9 is supported by the graphic card.

TIP:

{‘dg} NovaStudio plus cannot play videos without a graphic card supporting

DirectX9.

» DirectX features are activated

To activate DirectX features, open DirectX Diagnostic Tool (type in dxdiag in the Run
dialog and click OK, as shown in Fig.1-1) and enable all DirectX features on the Display

page, as shown in Fig.1-2.

= Tvpe the name of & program, folder, document, ar
Internet resaurce, and Wwindows will open it Far wau.

Open: :I::-:: dia

[ Ok, l[ Cancel ][ Browse...

Fig.1-1Run dialog
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¥ DirectX Diagnostic Tool @@|@

| S__l,ls_tem Directs Files | Display | Sound || Music 1 Input | Metwork,

Device
Mame: Intel{R) G41 Express Chipset
Manufacturer: Intel Corporation
Chip Type: Intel{R) 4 Series Express Chipset Family
DAC Type: Internal
Approx, Total Memory: 256.0 MB
Current Display Mode: 1024 x 768 (32 bit) (60Hz)

Monitor: Default Monitor

Direct® Features

Maore Help_

Drivers

MMain Driver: igxprd32.dll
£.14.0010,4990 (English)
112008 10:51:25

es

‘ersion:

Date:

WHOL Logo'd:
Mini YOO
VDD

DDI Yersion:

igxpmp32.sys
nfa
9 {or higher)

Test DirectDraw ]

| [ Test DirectaD |

DirectDraw Acceleration:  Enabled [ Disable
Direct3D Acceleration:  Enabled [ Disable
AGP Texture Acceleration: Mot Available

Motes

+ Mo problems found,

+  Totest DirectDraw functionality, click the "Test DirectDraw” button above,
+  Totest Direct3D Functionality, click the "Test Direct3D" button above.,

|

Mext Page H Save Al Information... ] [ Exit

Fig.1-2 Display page

Attention:

A

Do not install the universal decoders or decoder packages similar to the
universal decoder. Conflicts between the decoders within these packages

may cause failure in media playing.

Please contact us for special media formats supporting.

1.3 Media Types Supported

Media Format or Definition

Display Properties

Picture bmp, jpeg, ico, png, gif

background color, background

picture, background music,

Phone: NovaStar (Xi’ an) 86-29-84507048

Website:www.novastar-led.com

NovaStar (Shenzhen) 86-755-33592492



NDOVASTAR

NovaStar Tech Co.,Ltd

transparency, entrance/exit
animation, animation speed,
displaying scale, displaying

duration

wmy, asx, asf, mpegl, mpeg2,

mpeg4, h.264, DVD, VCD, xvid,

background color, background

Video picture, sound volume, displaying
divx, mov, mp4, rmvb, avcl,
scale , overlay Text
QTRLE
background color, background
Flash swf picture, transparency, displaying
scale, overlay Text
displaying scale, displaying
duration, transparency, color
Office files | docx, doc, xls, xlIsx, txt
inversion, duration for each screen
content
background color, background
Audio mp3, wma picture, sound volume,

transparency

Complex Text

Text with customized content,

background color, background
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font, color and style. Size,
background color, foreground
color and style for each

character are settable.

picture, transparency, entrance/exit
animation, animation speed,

duration for one screen of content

background color, background

picture, transparency, font, font

different frames with specified

effects.

Static Text | Text for static display color, line spacing, character
spacing, font style, align, display
duration

Text that is arranged in one line | background color, background
and can be de divided into parts | picture, transparency, font, font

Single Line

to shown on the display at color, font style, entrance/exit
Text

effects, duration for one screen of

content

Scrolling Text

Text that is shown repeatedly.

background color, background
picture, transparency, font, font
color, font style, repeating speed,

duration

Analog Clock

Clock with panel and hands of

background color, background
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hour, minute and second. picture, transparency, time mark
style and color, date, weekday,
lunar calendar, label, duration
background color, background
Clock that gives time
picture, transparency, font, font
information of year, month, date,
Digital Clock color, font style, year, month, date,
hour, minute and second in
am/pm, lunar calendar, hour,
digital number.
minute, second, weekday, duration
Transparent display, background
color, background picture, font,
Keep time or countdown font color, font style, keeping time,
Countdown | according to the time duration countdown, starting date and time,
Timer being set; display day, hour, time duration, displaying day,
minute and second. displaying hour, displaying minute,
displaying second
Decrease or accumulate Transparent display, background
Digital count | according to the starting time | color, background picture,
Timer or target time being set; display | transparency, seconds counter
hour, minute and second. type, color of the number, starting
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time, target time

Transparent display, background
color, background picture,
transparency, style of the clock,
time duration, styles of hour hand,

minute hand and second hand,
Display a clock with dial plate,
border colors of hour hand, minute
hour hand, minute hand and
hand and second hand, blending
second hand, with the style and
Vista clock modes of hour hand, minute hand
color of the dial plate, hour
and second hand, internal and
hand, minute hand and second
external border colors of the clock
hand being editable.
center, blending mode of the plate

surface, glass style, angle of glass
style, background picture, internal
and external border color, blending

mode of border

Transparent display, background
Display weather information of
color, background picture, city,
the designated city, including
Weather Info updating time, time duration, basic
weather, temperature, wind
display (font, font color, text effect,
force, humidity, air, UV
multi-line, static or rolling,
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displaying weather, temperature,
wind force, humidity and current
temperature, setting of words)
user-defined display layout (new
style, imported style )
Web pages at world wide web of | Website address, area of a web
Web Pages | given website address or local page to be shown, transparency,
web pages of given path. duration
External Standard steam media devices Video device, audio device, video
Devices such as USB camera, TV boxes in, channel, display scale, duration
Display the windows, background
External All .exe executable programs in
color, background image,
program the local computer
coordinate and duration of view
Transmit to client’ s media
Streaming through steaming media server | Volume, playing duration
by stream protocol (RTSP, MMS)
Current ambient temperature
Temperature Background, font, text effect, unit,
and humidity acquired by
and Humidity duration, period
temperature and humidity probe
RSS Network information (xml) and | Background, transparency, play
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Rss files (.xml) on local disk duration, update cycle, display

mode, and display style

Table.1-1 Media Types

2 Play Program

In NovaStudio plus, a play program is the unit for media play on a LED display. Each LED

display has one corresponding play program at one time.

Play program includes time frame priority program and page priority program. Time frame
priority program means that program is edited according to time frame; the program
includes multiple time frames, and pages will be added in the time frames; page priority

program includes multiple pages, the play time of which is set separately.

2.1 Priority Program of the time segment

Play program can save as the file which extension is .plym, it is composed by several
common segments, otherwise, it can also contain one or more inserted segments. The
common segment and inserted segment is composed by one or more pages, and each
page is composed by one or more windows. The window can be divided into Common
Window, Clock Window, Scroll Text Window, Countdown Timer Window, Weather
Window and Video Device Window. The Common Window can contain one or more

different types of media. One example of play program structure is shown as Fig.2-1.
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Common Segment

={d] Pagel
7] Common ¥indc

=Ml Page2

[T Clock ¥indos

™) Common ¥inde Timing Inserted
Segment

Mx Cycle Inserted
Segment

4 m »

Fig.2-1 Example of play program

< Common Segment

The segment has these time properties: Effective Date, Effective Days of the Week,
Effective Time of the Day.

For Example: The common segment Segmentl, from June 23, 2012 to June 30, 2012, every
Monday,

Wednesday, Friday, played from 8:00 to 12:00, as shown in Fig.2-2.
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LET

= !ASeg-entIditingAreﬂ-

B RetdX» 0000

Play Program

JSegnentl (2012/8/23

: | Pagel

i D Common Winde

5-[M| Page2 Time Property
{71 Clock Windew Effective Date

) +[7] Common Windc [7] No Date Limit From 2012/ 6/23 <~ T, 2012/ 6/30 ~
[=)-%£) Inserted Segment2

Name: Segmentl

/M| Pagel Effective Day of the Week
n i F] a1 (V] Monday [7] Tuesday [V] #ednesday || Thursday
=483 — e =
=549 Ix}serted Sepuentd | V] Friday [7] Saturday [ | Sunday
= !J Pagel
L Effective Time Of the Day
=] w2 [ A1l Day  From 08:00:00 2 To [H:00:00 .

Fig.2-2 Common segment Segmentl

< Timing Inserted Segment

The segment is started to play for specific times or duration at a specific time point in
effective days of
effective date. It has these time properties: Effective Date, Effective Days of the Week and

several Specific Time Points.

For Example: Timing inserted segment Segment2, from June 23, 2012 to June 30, 2012,

every Monday, Wednesday, and Friday, played at 8:30 for 1 times, as shown in Fig.2-3.

Phone: NovaStar (Xi’ an) 86-29-84507048 NovaStar (Shenzhen) 86-755-33592492

Website:www.novastar-led.com




NV STAR NovaStar Tech Co.,Ltd

? Screenl 1

= [Se entiditin Area |
‘5... Play Program ‘ 5 '] v_g- 3 = £ - I
=-4Z) Seamentl (2012/6,/23 H@- B2 tdXD OO O

(Ml Pagel
E] o onii A Name: Inserted Segment2
:’ _J_J Page2 Time Point List

“.[7] Clock Window

i [08:30] [2012/6/23 To 2012/6/30] [Monday, Wednesday, Friday]
‘] Common Windc

x &)

Flay Property

When reached the () Play O ~Iminutes U - seconds

time point _ -
% @) Play |1 5 times

7] T m— »

7l Show window name and
S index

Fig.2-3 Timing inserted segment Inserted Segment2

< Cycle Inserted Segment

The segment is played for specific times or duration at regular intervals in effective time of
effective days of effective date. It has these time properties: Effective Date, Effective Days

of the Week, Effective Time of the Day and Play Intervals.

For Example: Cycle inserted segment Segment3, from June 23, 2012 to June 30, 2012,

every Monday,

Wednesday, Friday, from 8:00 to 12:00, played one time every 30 minutes, shown as Fig.2-4.
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. ? Screenﬁ

jisegnent Editinghrea 1

- Play Program .
£1-£2) Segmentl (2012/6/23 - a2t dIXD> OO

=[] Pagel

T.Jm[jag;ommon Windc Name: Inserted Segment3

fzj !] Page2 Play Froperty
D Clock Window ) Play 0 * minutes O | seconds
i ] Common Winde Every 30 7 minutes

|-42) Inserted Segment2 ©) Play 1 7 times

-‘:J Pjagel [V] Pause current play when playing inserted segment
| W

Crart et vewk] | Time Property

Effective Date
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»
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< m. | P

7] Show window name and
|

= index

Fig.2-4 Cycle inserted segment Inserted Segment3

< Page

A page is an area on the computer display screen that is mapped to a LED display for

showing visible media sources (such as videos, pictures and text) on the LED display.

® Global page

Global page is a special common page that it always stays on the front of all other common
pages. In the case that common pages of different window layout are needed while a
window at a fix position is also required (such like that for clock, weather info or scrolling
text), putting the fix position window in a global page is the best way for the window layout
design. But if only one common page is needed, a global page may not be necessary as the

fix position window can be set directly to the position required.
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® Common Page

A common page can have multiple windows and the layout of the windows can be
customized. A segment can have multiple pages. And of course, the window layouts of
these common pages can be different from each other. The common pages will be shown
in the order they are listed in the segment. Normally, one common page is enough for a

segment.

<  Window

A window, also named a play window, is an area of a page in which visible media sources

will be show. Note that any window must be affiliated to a page.

® Common Window

A common window could have its own media sources list and thus different types of media

sources can be played in it in the list order.

® Scroll Text Window

A window that is only for showing scrolling text.

® Clock Window

A window that is only for analog or digital clocks.

® Countdown Timer Window

A window that is only for showing information from a time meter.

® Video Device Window
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A window that is used only for showing videos from an external video device.
® Weather Window

A window that is only for showing weather information.
® Temperature and Humidity Window

A window that is only for showing ambient temperature and humidity.

2.1.1 Play Program Dispatch Rule

If there are conflicts between the playing times of segments, follow the below rules:

A. The back one has the higher priority for the same type segments.

B. If the timing inserted segment has the same playing time point as the cycle
inserted segment, play the timing inserted segment.
You can view the dispatching result between different dates in the Play Program Editing

Area.
For example:
< Common Segment

Suppose time properties of segment A and segment B are set as follow:

A B
From June24, 2012 to June 30, 2012 From June24, 2012 to June 30, 2012
Every day in a week Every day in a week
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From 8:00:00 to 15:00:00 in each day

From 8:00:00 to 12:00:00 in each day

If B is at the back of A in the play program, then B has the priority to be played on

time confliction. The dispatching results will be shown as Fig2-5 (In June 24, 2012).

“._ﬂ Sereenl ‘

B reocen

<) A(2012/6/24/2012/6
-££) B(2012/6/24/2012/6

&~ | W

From

Date Range of Schedule

2012/ 6/24 [~

( e
iPlayProgran!d1t1ngkrea%

Ta 2012/ /24 [E~

B-2012/6/24
\;#Common Flay
B [8:00-12:0
L. A [12:00-15:

0]
00]

Fig.2-5B has higher priority than A

® Otherwise, if A is at the back of B in the play program, then A has the priority to be

played on time confliction. The dispatching results will be shown as Fig2-6(In June

24, 2012).

i? Sereenl

I
1

B oo |

PlayProgral!ditingArea}

9 B (2012/6/24/2012/6 ZE A 4

) A(2012/6/24/2012/8

Date Range of Schedule

From

2012/ 6/24 [~

To 2012/ Bf24 [J~v

=-2012/6/24
[=)-Common Flay
i [8:00-15:00

]

Fig.2-6A has higher priority than B

< Timing Inserted Segment

Suppose time properties of timing inserted segment C and timing inserted segment D are

set as follow:
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C D
From June24, 2012 to June 30, 2012 From June24, 2012 to June 30, 2012
Every day in a week Every day in a week
At 8:00, 15:00 At 9:00, 15:00

® If Dis at the back of C in the play program, then D has the priority to be played at

the same time point (15:00). The dispatching results will be shown as Fig2-7(In

June 24, 2012).

—;.i Sereenl 1
E | PlayProgramEditingArea|
B & | P
48 D Date Range of Schedule
From 2012/ B/24 [0~v To 2012/ 824 [~ Refresh

D [9:00]
D [15:00]

Fig.2-7D has higher priority than C

® Otherwise, if Cis at the back of D in the play program, then C has the priority to be

played at the same time point(15:00). The dispatching results will be shown as

Fig2-8 (In June 24, 2012).
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? Sereenl ’

EEer s reocran |
- L

{ PlayProgramEditingArea :

Ov b o
-4 C Date Range of Schedule

From 2012/ 6/24 [[Jv To

2012/ 6/24 [v

- 2012/6/24

T i [s:00]
D [9:00]

L.C [15:00]

Fig.2-8C has higher priority than D

< Cycle Inserted Segment

Suppose time properties of cycle inserted segment E and cycle inserted segment Fare set

as follow:
E F
From June24, 2012 to June 25, 2012 From June25, 2012 to June 26, 2012
Every day in a week Every day in a week
Play Interval: 30 minutes Play Interval: 30 minutes
[

If F is at the back of E in the play program, then F has the priority to be played on

time confliction. The dispatching results will be shown as Fig2-9
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? Sereenl

( T |
PlayProgramEditingArea
EREElPlay Program ~ Sk s £ I

Date Range of Schedule

From 2012/ 6/24 [Jv To 2012/ 6/26 [I~

-2012/6/24

= Inserted Flay

5 .. B [0:00-Next Day 0:00][Every 30 Minutes]
£ 2012/6/25

P B Inserted Flay

; .. F [0:00-Next Day 0:00][Every 30 Minutes]
£ 2012/6/26

B Inserted P

(.F [0:00-Next Day 0:00][Every 30 Minutes]

Fig.2-9F has higher priority than E

® Otherwise, if E is at the back of F in the play program, then E has the priority to be

played on time confliction. The dispatching results will be shown as Fig2-10

—? Sereenl

| PlayProgramEditingArea |
E;w Play Program . ’ 2 = & J

GZyv 'v}

Date Range of Schedule

Fron 2012/ 6/24 [~ To 2012/ 6/26 [+

-2012/6/24
B-I nserted Play
.. B [0:00-NWext Day 0:00][Every 30 Minutes]
-2012/6/25

E)-Inserted Play

-0

: ‘. E [0:00-Fext Day 0:00][Every 30 Minutes]
5-2012/6/26

B- Inserted Play
. ¥ [0:00-Next Day 0:00][Every 30 Minutes]

Fig.2-10 E has higher priority than F

Note: If there is no confliction between two cycle inserted segments, but they has the same

playing time point, still follow the same dispatch rule(the back one has higher priority).

For Example, suppose time properties of G and H are set as follow:
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From June24, 2012 to June 25, 2012

From June24, 2012 to June 25, 2012

Every day in a week

Every day in a week

Play Interval: 20 minutes

Play Interval: 10 minutes

If H is at the back of G, H will be played at 00, 20, 40 minutes of every hour. Otherwise, play

G.

If one time point of timing inserted segment is the same as one playing time of cycle

inserted segment, play timing inserted segment.

For example, suppose time properties of cycle inserted segment I and timing inserted

segment L are set as follow, it would play L when arrived at 10:30.

From June24, 2012 to June 25, 2012

From June24, 2012 to June 25, 2012

Every day in a week

Every day in a week

Play Interval: 30 minutes

At 10:30
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2.1.2 Edit Play Program

2.1.2.1Display Window Setting

Before editing a play program,, the mapping area of the current physical LED display on the
computer display should be specified first. The position and size of the mapping area can
be set through the Display Window Setting dialog shown in Fig.2-11. To open the Display

Window Setting dialog, select Settings ->Display Setting form the main menu.

Display Setting ‘_E_}
g e :
Screenl 1

Name: Screenl
Start X:0 | #igtn: 640 =
Start ¥:0 + Height: 480 5
On Top: () Never

@ Playing

(V] Show Screen (Shift+H)
[ ] Lock Screen (Shift+L)
Hote:After the screen is locked, it is

unable to use the mouse to change the
screen size and position.

[ 0K ][ Cancel ]

Fig.2-11 The Display Setting dialog

2.1.2.2Edit Segment

1) Create

Click the button on the toolbar of Play Program Editing Area, or right-click on the Play
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Program Node, or right-click on the screen, a menu pops up shown as Fig.2-12 for adding
new segment.

? Screenl }
| PlayProgramEditingArea '
~~~~~ = ' :
\‘).I »

[ Common Segment

Inserted Segment ¥ botzf e/28 [~

Copied Segment

[ l

_.ﬂ Sereenl l

[Play!
----- |

Add Common Segment

Add Inserted Segment »
Add Copied Segment

Clear

Play

2‘
‘Aj
("' ‘14 ("‘ '14
>
&W-\ ﬁqu

Add Inserted Segment

Add Copied Segment

Clear

Fig.2-12 Add segment

2) Editing Properties of Segment

You can edit the properties at the Segment Editing Area after adding the common
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segment or inserted segment. Shown in Fig.2-13, Fig.2-14, and Fig.2-15 is the

corresponding property page.

? Sereenl I

[Seglent!ditingkrea‘
E]--- Play Program 3 =7 I " . " :
.‘ gv BRa4+ S X O000O

) Inserted Segment2 S il
- : egmen
(Z) Inserted Segment3 Bass .
Time Property
Effective Date

[7] Mo Date Limit  From 2012/ B/2 To [2012/ 6/30

Effective Day of the Week

] a1 Monday [V] Tuesday fednesday Thursday
Friday [V] Saturday [V Sunday
Effective Time Of the Day
All Day From 16:00:00 To |17:00:00

Fig.2-13 Properties page of common segment

? Secreenl
= i SegmentEditinghrea }
=-5Z] Play Program : - - - - =
LD Segmentl v@' Beae4t+dIXY OOOOO
Inserted Segment2 T ted S ©
\?) Inserted Segment3 ate: IENREEREESAEmeD.
Time FPoint List
Flay Property - -
M aneneachedsihe () Play 0 minutes O seconds
time point, _ - =
@ Play |1 5 times
[V] Pause current play when playing inserted segment
Show window name and
@ index

Fig.2-14 Properties page of timing inserted segment
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4

+' Secreenl

: Segment EditingArea :

@ 2e44%X% 00000

Ej Play Program
<) Segmentl
££) Inserted Segment2

: Inserted Segment3
s)Inzerted Segment3 L =

Flay Froperty

(") Play 0 “ minutes U 5 seconds
Every 30 % minutes
@ Play 1 = times

[V] Pause current play when playing inserted segment

Time Property
Effective Date

[7] Wo Date Limit  From 2012/ B/25 To 2012f

Effective Day of the Week

@) a1 [V] Monday [V] Tuesday (V] Wednesday [V| Thursday
- [V] Friday (V] Saturday V] Sunday

Effective Time Of the Day

[V] A11 Day From [16:00:00 2| T¢ 117:00:00

@ Show window name and
W index

Fig.2-15 Properties page of cycle inserted segment

You can add one or more playing time point for the timing inserted segment.

For inserted segment, if Pause current play when playing inserted segment is selected,
the current common segment play (If has) would be paused and hide if begin to play
inserted segment, otherwise, the inserted segment and the current common segment

would be played together.

Use the toolbar on the right or right-click menu, you can copy, paste, move or delete the

selected segment. The toolbar and menu is shown as Fig2-16.
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’.q Sereenl \

= ,{f] Play Program

Inserte
45) Inserte

h 2012/ 6/24 To 2012/ 6/30

ek

[V] Tuesday  [V] Wednesday |[V] Thursday
Move Down = :
|V| Saturday |V| Sunday

Delete
ay

00:00 : To [17:00:00

"® Screent l

"
3
3
N,

= Play Program

Inserted Segment2
4ig) Inserted Segment3

Q
v

Add Common Page
Add Global Page
Add Copied Page
Copy

Paste

Move Up

Move Down

Delete

Clear

Preview Current Segment

W'

€72

<\

L)
(%)
<
<
N,

Fig.2-16 Menu of segment

3) Statistics of the time duration

Select the time frame of the playing scheme; click O to check time-consuming by the

pages.
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Schedule(P} ControlilC}  Seftings(S) View(VW) ToolT})  Plug Tool(U} Language(A) Help(E}  Lock(O)
RN N EEE- g

-—_! Screeni

If Segment Editing Area ]I

= schedule _
H = - HEHEBIUEN]
SormEmm (@ Retdxvo
" Page1
EI |Z| ¢ . Name: General Segmenti
R Ij Common Wind
=-[l| Pagez Time Property
- Wi Effective Date
- waz [ NoDateLimt  From |2014-01-21 To  [2014-01-21
Effective Day of the Week
o Monday Tuesday Wednezday Thursday
Friday Saturday Sunday
Effective Time Of the Day
All Day From |12:00:00 =|[To  |Mext Day 19:00:00 e
1| il | »
Show window name and
index
New Schedule
. '
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Jeri... Fage name Time—consuming
1t Pagal 00:00: 00
Z FagalZ Loap
|
Exit
Fig.2-17 Page statistical information of time-consuming
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2.1.2.3Page Editing

1) Create a new page

Click the button on the toolbar at Segment Editing Area to add a Common Page or

Global Page, as shown in Fig.2-18.

? Screenl ‘

: Segment EditingArea ‘\

= Play Program -
o - o 4 'y ™~ ¢ "
@ metdx>0
Inserted Segment2 ,!] Common Page I
i4iZ) Inserted Segment3 ] ‘ﬂ Global Page

P2

Copied Page

Fig.2-18Add page
2) Properties Setting

The properties of the added page can be set through the property panel. Shown in Fig.2-19

is the property panel.

{ Page Editing Area }

O BE2E XD Q00 O O C
Hame: Pagel

Play Type: [Cycle ']

Pla; O = .

Duriti on: 00:06:00 5| Play Times: (!

Background
Color:
Background
Image:

gi sp]_.ay [Stretch v]
¥pe:
Back Music: - KR f & b
Fig.2-19 Properties of page
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There are three options for Play Type, Cycle, Specific Times and Specific Duration. If Play
Type is set to be Cycle, this page will be shown repeatedly; if Specific Duration,
NovaStudio plus will shift to the next page after showing this page for the time specified by
Play Duration; if Specific Times, NovaStudio plus will shift to the next page after all the

play windows finish playing their media sources repeatedly for N times (N is specified by

Play Times).

Area of the page that is not covered by windows will show the background picture or color,

as shown in Fig.2-20.

Play Window

Fig.2-20background with background picture

The play type is only Cycle for global page. The global page will be always playing during

the segment playing.

Use the toolbar on the right or right-click menu, you can copy, paste, move or delete the
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selected page. The toolbar and menu is shown as Fig2-21.

# Screenl

.| Play Program
- Q Segmentl
- N
iz W}

i) In:oruc‘ Add

© Insertet A0 Clock Window
Add Countdown Timer Window
Add Device Window

Add Weather Window

: <

loolbar

Copy
Delete

1 \ALL p
eqa wWinaov

Clear Window

: Right-click menu
ve Window Layout of Page L >
7 Show window nam
“index Preview Current Page
Previ f P
New Play Program review Cugrent Segment from Cugrént Page
J Sereenl

mon Window(for kindsef media)

Play Program
f) Segment!

o ¥
Clw

'f,) Inserted Segment2
*f) Inserted Segment3

Add Scrolling Text Window
dd Clock Window
Add Countdown Timer Window
Add Device Window
Add Weather Window

Copy
Paste
Delete

Right-click menu

Add Copiea Window

Clear Window — Scr(‘;"
Save Window Layout of Page
Préwjew Current Page
Preview
Fig.2-21 Menu of page
Phone: NovaStar (Xi’ an) 86-29-84507048 NovaStar (Shenzhen) 86-755-33592492

Website:www.novastar-led.com




NOVAISTAR NovaStar Tech Co.,Ltd

2.1.2.4Window Editing

1) Create a new window

After adding a page, you should add windows to the page. For example, click the button

shown in Fig.2-22 to add a common window to the page.

:’A Sereenl

\'7‘;1 P1 P i’age Editingﬁrea . <
=2 ay trogram [ ] =

-).4Z) Segmentl 0| B P XY QO

T

Common Window(for kinds of media)

Scroll Text Window

ﬁ} Inserted Segment2 Clock Window
#2) Inserted Segment3 v .
Countdown Timer Window

Video Device Window
Weather Window

Fig.2-22 Add window to page

The newly added window will be on focus and also shown on the computer display after

the add operation, as shown in Fig.2-23.

! Sereenl

= ?’3 Play Program
= ‘/ Segmentl
—-|dl| Pagel

£2) Inserted Segment?

fj Inserted Segment3

Fig.2-23 Added window
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2) Window position and size setting

The position and size of a newly added window may need to be reset as the default values
are unlikely to meet the requirements. These values can be reset directly by using the tool
provided in NovaStudio plus, as shown in Fig.2-24. A more intuitive way to reset these
values is to use the mouse. Click on the window to put focus on it and then set its position
and size by drawing, pulling and squeezing, as shown in Fig.2-25. The arrow keys and their

combination with Shift keys can also be used for the position and size setting of a window.

Name: |V

X 16 @A ¥ 00 S| Width: 102 | Heightl146 £

Fig.2-24 Tools for window position and size setting

Fig.2-25 A focused common window

To show all the windows of a page, just select the page from the page list. This could be

very helpful for windows layout adjustment.
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Fig.2-26 Showing all windows of a page
3) Border setting

The newly added window defaults to single line border. Click “Border Setting” to set

border thickness and set window border as double-lined, as shown below.

Window Editing Area
EEN - S |

Mame: |Common VWindow1 Border Setting

X 0 N N & [Width: (200 % |Height: |200 |%&

Q) Fie XY 4+ 4% 7=

ol Window Border Setting x
Fidth:
C‘ Hone
(O Single Line

(%) Multi-Line
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4) Delete a window

Fig.2-27 Frame Setting

To delete a specified window, click the circled Delete button, as shown in Fig.2-28.

"
. Screenl

Play Program
,i;‘ Segment!
d Pagel

Clw

e e S Y {
MR{Conmon ¥inddf

Q Inserted Segment2
i%) Inserted Segnent3

5) Move a window

Lol

| Name:

[ X:

YindowEditingArea
X0
Conmon Window2
2T 15 y: 206 - width: 388 S Height: 97
\ - X%t 8|E1x

Fig.2-28 Delete window

For overlapped windows in the same page, the one at front will cover those under it.

Suppose a common window and a clock window is added to a page at the same position of

(0, 0, 200, 200). The common window will cover the clock window when this page is on

shown if the common window is in front of the clock window in the window list. To avoid

the clock window being covered by the common window, move it to the front of the

common window or move the common window to the back of it. The circled arrow buttons
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in Fig.2-29 are use to move a window forward or backward.

'® Screent ]

Upper Laye |
——{elinemen T 0" (N Y
=) 4£) Segmentl :
Lower Layer NNl Pagel . ——
= & Neme: Clock Window2

[ Common Winde =

O EEEx ¢
4@ Inserted Segment2 =
42 Inserted Segnent3 | Clock Type: © Anelog C.

Back: |.| '"_StnAtch

K Seale: [Mizly: 5 B

Y: :0 I

Fig.2-29 Move window

The result of a transparent clock window on top of a common window (showing a picture)

is as Fig.2-30.

Fig.2-30 Result of a overlapping transparent clock window on a common window

6) Duplicate a window

To duplicate a window, select the source window, click the Copy button and then click the

Paste. Circled in Fig.2-31 are the Copy button and the Paste button.
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¥ Screent
[l *lay Progrea l YindowEditingArea
1£) Segment] i B e v R |
. ;‘;om Wmdow‘ Name: Common Windowl
| Conmon ‘ x: 0 Gl S + Width: 200 3 Height: 200

Fig.2-31 The Copy button and the Paste button

The right-click menus on the window node and on the window zone in the screen are also

supported to edit the window, as shown in Fig.2-32.

2 Screenl

| Play Program

i£) Segment! hetsx
d| Pagel iNue Common Windowl
p Layer 7] Clock Window
Nesiiin s =1 [y | | y: [0
i2) Insex p Layer
Copy J Inser . :
Paste
Copy
Delete Paste
Positon Delete
Size .
Positon 1
Add Media St elect 53 |
Clear Media : oz =
Add Media
lear Media

Fig.2-32 Right-click menu of window

7) Total time of the media

Select the general window; and select all medias in the media list, click to check

the detailed dispatching table and theoretical playing time of the media.
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Total Duration of Playing Media [ S|

Scheduling detail table

Zerial ...  Media name

0000000001 01 340957 jog
0130000001 69351 23023933323107 jog
20110614040909281 2 g
0130000001 69551 230259555251 07 jog
20110614040309251 2 jog
0130000001 69351 23023933323107 jog

TrAA OCA AT d 000 T e
I F

m

A0 k) LRI L) R =

Total pages 1 Home page  Previous page 1 Rext page I:I Jump pages

Statistical infarmation
Theory time 00:00:55

ﬂ 1.The actual time (theoretical time + code execution time)

2.The duration of playing media calculated is just for reference, please subject
to the actual play;

3.The duration of playing file and complex text is corresponding to the size of

window and scale of dizplay, when the zize of windowe and scale of display
changed, the duration of play may change.

Exit

Fig.2-33 Total playing time of the media

2.1.2.5Media Editing

Media editing will be illustrated with a common window as an example.

1) Add a media

Media sources of a media type that is supported by NovaStudio plus can be added to a
common window for showing. Refer to 1.3 Media Types Supported for information about
the supported media types. Click the circled button in Fig.2-34 to access the drop-down

menu of media types. Select the corresponding item to add a media source of that type to
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the common window.

(0 H R D |

28 screent |'¥ Screenz | M Screen3

Play Program(P}  Control{lC}  Seiting=(S) View(V) ToolT} Plug Tool{U} Language(A) Help(E} LockiO) N %;E\_ g;
== HA

- -

=i

22 3 3 B

= | Window Editing Area |
= I Play Program —

=) B NN R O ]
=8 - [
IBREH
SrEn x o v [0 $|with (235 3] Heioht: 19 (3]

(1 [The.Mob.Doctor 501E08 hdtv.x264-2n¢ [ -~ 1|
2

Streaming p——
nsert Media... »
3 Temerature and Humidity Complex Text

Static Text
Single Line text
Scroling Text
Path: |C:'\D|qument3 and Settings\Administratorily Documents) g
Analeg Clock
Back: M | - Stretch w
[—]| I Digital Clock
Transparency:

Countdown Timer

Volume: ; J 100 E] Temperature and Humidity
Position: —{1 00:05:28 URL
< | 3 v . .
— = . - Video Device
Show windew name and Duration: 00:42:44 544 Overlay Text Edit Text
index Application
Streaming
New Play Program 1582
—.-,—- Copied Media

Fig.2-34 Add media

2) Media properties setting

Properties of a media source can be set is related to the type of the media source. Refer to
1.3 Media Types Supported for information about the settable properties of a certain type
of media. Settable properties of the selected media item in the media source list will be
shown on the property panel, as shown in Fig.2-35. Modify the property settings of a

media item through the property panel if required.
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: | YindowEditinghrea|
Bt I X
. (T
. P Brp Bra T ke ie

girl. jpg

T Be XY +E|Er

Path: E:'girl. jpg

Back: [.| v][Stretch v
Background =

Music:

Transparency: <

|=

In Effect |Random

[7] Out Effect |Random

Seale: [Fi1l

] » 1008
v|speed: 5 [Hots
~  Speed: 5 ﬂ:-‘iO.ls
;]Stay: £

Fig.2-35 Properties page of media

3) Set play times of media

Select the media in the list, then double click the Play Times Grid to change the play times:

You can manually enter a new number or select the existing number in the drop-down, as

shown in Fig.2-36.

E-he Xy e

4 )
2 |oppo. AVI |Any Times
(1)
0] E-hEe XYtk

1 |girl. jpg

(2)

Fig.2-36 Change play times of media
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The media scheduling is related with the play type of current page, described as follows.

< If there is three media A, B and C of one common window, the corresponding play time

is 1, 2 and Any Times, the play order is as follows:

® The play type of pageis Cycle: ABCBCCCC......

® The play type of page is Specific Timesas2 : ABCB|ABCB

® The play type of page is Specific Duration : ABCBCCCC......

< If there is three media A, B and C of one common window, the corresponding play time

is 1, 2 and 3, the play order is as follows:

® The play type of pageisCycle: ABCBCC|ABCBCC|ABCBCC]|......|......

® The play type of page is Specific Timesas2 : ABCBCC|ABCBCC

® The play type of page is Specific Duration : ABCBCC|ABCBCC|......|......

4) Preview a media

Click a media item in the media list to preview it in the current window (in this case, the
current window is a common window). New property settings will take effect immediately
even they are set during the previewing. The first media source in the media list of a

window will be automatically previewed when the window is selected.

Users can set and click media preview modes in the following manner. The operating steps

are as follows:

Click "Setting” —" Preview setting of media” on the toolbar to enter the interface

Phone: NovaStar (Xi’ an) 86-29-84507048 NovaStar (Shenzhen) 86-755-33592492
Website:www.novastar-led.com




NOVASTIAR NovaStar Tech Co.,Ltd

shown below:

o5 Preview setting of media X

When click to preview (@ only play one time.
media,
loop play.

@ black screen.

When preview

finished,
() keep last frame.

Fig.2-37 Media Setting

The user can set media clicking preview at “only play one time” or “loop play”
according to the practical demands. If “only play one time” is chosen, “black screen” or
"keep the last frame” may be selected upon the completion of media preview setting

with the options below.

5) Move a media item

Use the ® ¥ buttons to move a media item in the media list forward or backward and
thus change the play order of the media sources. Mouse can also be used to move media
items. The red line in Fig.2-38 indicates the new position of the mouse item dragged by the

mouse.
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ship. wmv

Fosniom O im
£ali0Z jpg
gZIrL. JPE

goldl. jpg
gold 2. jpe

£a1102. jpg
Fig.2-38 Move a media item by mouse
6) The copy and paste of media

Click button @ to copy the selected media, and click button B (o insert the copied

media after the selected media.

7) Apply the media properties to others

Select a media, and then click button | 2] , choose the media to apply to in the pop up

dialog.

[¥indowEditinghres|

e tdX
Apply properties to...... X

o ¥ pply prop
¥ .07 ‘:—L ¥ : rﬂ () A1l other media of the same type
o @ Select media from list
1 1 [V] foreign_ 2. jpg
2 |foreignz jpg || |[ixl re
3 lgirl. jpg
Path: E:\fos
Back:
Background F
Music:
Transparency: <
[V] In Effect
[7] Out Effect  Random
Scale: [Fin1 v|Stay: S 4 Sec

Fig.2-39 Apply properties to media

Otherwise, the media operation also provides the corresponding right-click menu, as
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shown in Fig.2-40 and Fig.2-41.

O T Re X%t Er
1 e
2 foreign, Move Up .
3 zirl. jps Move Down T
Copy
Paste —
Path: Insert Media >
Back: Delete
Background : 3 B
Music: Apply Properties to... [3
- o -

Fig.2-40 Right-click menu of selected media

5 C-hexvy|(ty|E
1 |foreign_1. jpg ;
2 |foreign 2. jpg -
3 igirl. ipg lﬁmy Times
File
Complex Text -
Please select Static Text
the item in Single Line text
Scrolling Text
Analog Clock
Digital Clock
Countdown Timer
Weather
URL

Video Device

Add Copied Media

Fig.2-41 Right-click menu of blank zone

2.1.2.6User-defined weather forecast

This software supports user-defined layout of the weather forecast. Users can make

weather forecast style more worth-seeing according to their likes.
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After a weather forecast media is added in the window, enter "edit attribute" —

"user-defined display” — "layout editing", as shown in the following figure:
Schedule(P} ControllC}  Settings(S) View(W) Tool(T) Plug Tool(U} Language(A) Help(E) Lock(O})
O HE D« 2
? Screen
[ Window Editing Area
=55 Schedule e
£-#£3 General Segment Betdx
BI:' Page1 Mame: Common Window 1 Border Setting
I o
| ... Common Windi LE |EI IE" ks |EI IE" et nght: I
, B---@;gﬂ 0 E-h2aeXY| 4+ E =
i W1
Ij W2 1 000000000101340957_1 jpg 1
...... 2 013000000165598123025958525107 jpg 5
| 3 |201108140408092812 jog Any Times |
|
-
Basic attribute| Edt atirbute ) |
() Basic display |
he layout is empty, please edit
4| [Tl | 3
Show window name and
index
New Schedule
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Weather type editor =B
FilefF) Edit(E) Add(A)

£l

Ly

I,

X | [S)[=

‘ 1

Fig.2-42 Weather style editing

Fixed text, fixed picture, weather text, weather picture, weather date can be added.

Fixed text: Explanatory note, generally words of location, weather, temperature, humidity
and wind force;

Fixed picture: Illustration pictures, any picture can be imported from the local;

Weather text: Description of weather, weather texts of today, tomorrow, the day after
tomorrow and three days from today can be selected and added;

Weather picture: Weather conditions indicated by pictures, weather pictures of today,
tomorrow, the day after tomorrow and three days from today can be selected and added;

Weather date: Today, tomorrow, the day after tomorrow and three days from today can be

Phone: NovaStar (Xi’ an) 86-29-84507048 NovaStar (Shenzhen) 86-755-33592492

Website:www.novastar-led.com




NOVAISTAR NovaStar Tech Co.,Ltd

shown in the format of date, time or week according to the time of the local system, and
the format of the date can be adjusted into the form of Month Day Year, Month Day and

others.

Fig. 2-43 shows a weather forecast sample that has been made.

Weather type editor ‘EEL_J

-

File(F) Edit(E) Add(A)
me |
") =
|
o
2014 - 01-24 N
£
—)
2014 - 01-25 s
Humi di ty: 2014 - 01-26 i
|ESEE -
@ Today Tomorrow The day after tomorrow Three days from now
Back: > || Tile V| Transparent
Area: X (12 B4 Y: |7 5H|width: |50 {5+ Height: (S0 (£
Fig.2-43 Weather forecast style that has been made
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2.1.3 Preview and Play of Play Program

2.1.3.1Preview

NovaStudio plus provides preview function of segment and page of play program. Select

the segment or page you want to preview, and click the O or & putton to start

preview.

The interface will show the preview information after preview started, as shown in Fig.2-44.
The preview information is including playing page information, playing window

information, the current playing media and the next media of every window.

Select Accelerated Preview, you can preview at different play rate.

Click button ™ to pause preview, and click button o to stop preview, return to

editing interface.

Otherwise, you can right-click on the screen, use the right-click menu to pause or stop

preview, as shown in Fig.2-45.
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? Screenl

5 { Seg-entlditinghea}
- | Play Program -
o2 OO0 0O0
-4 Pfgel Preview Item:Segment (Segmentl)
...... iR
Play Info
--Global Page

[i)---»Col-on Page (Pagel) Status:Playing
Elw ©, 328)
@ edia: oppo. AVI
Y efia: foreign_l. jpg

Play Error

D @)

Accelerated Preview

Show window name and Accelerated ., . - 1] 3

index Preview

Fig.2-44 Preview Page

Start Preview

Last Page
Next Page

Pause Preview

Stop Preview

Fig.2-45 Right-click menu of preview

2.1.3.2Play

After loading or editing over the play program, click the button P to start play the

current play program. As shown in Fig.2-46.
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P[0 e ]

‘ 3 Sereend |? Scr|Pl&5"h ? Screend

Fig.2-46 The button for starting play

After play started, the interface will switch to play page from editing page. The play page
will show the current common segment information (If has), the next common segment
information (If has), the current inserted segment information (If has) and the next inserted
segment information (If has), as shown in Fig.2-47. The fault information of play will show
in the Play Error List in red font.

O RHK PN & 2

—.a Screenl ‘

g‘e’;:ﬁ.cm’“"‘ Segmentl [2012/6/27 0:00:00 To 2012/6/28 0:00:00] Playing

Ee’;:eig'!“““‘ Segnent (In Segmentl [2012/6/28 0:00:00 To 2012/6/29 0:00:00]

Flay Info

~-Global Page :

;':;;--.»Comnon Page (Pagel) Status:Playing [ |
5% (0,0,359,328)

...... Current Media:oppo. AVI

Lo Wavt Madie: Favaion 1 ine

g‘e’gzﬁtf““’“d Inserted Segment? [2012/6/27 18:48:00] Playing

Hext Inserted
Segment (In a week):

Play Info

Inserted Segment? [2012/6/27 18:50:00]

>

é---‘Common Page (Pagel) Status:Playing
S-% (0,0,215, 184)
------ Current Media:Analog clock
E‘--.--Next Media:Analog clock =

m|

1

Play Error

) (¥

Fig.2-47 Play page

Use and @ button on the toolbar to pause or stop play. You also can use the

right-click menu on the screen as shown in Fig.2-48.
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S v\
W/ e \
Play(Shift+5)
Last Page(Shift+B)
Next Page(Shift+N)
Pause(Shift+P)
Stop(Shift+T)

Hide(Shift+H)

Fig.2-48 Right-click menu of play
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2.2 Priority program of the page

The program is composed of multiple pages, in which multiple image-text windows,
including text, images, videos, clock, timer, temperature & humidity and weather forecast,

can be added.

- . e & = B = 3 SN I S B S 3 I IS S E S S = | 9 % ¥ 3 =
Schedule(P) Control(C)  Seftings(S) View(V) Tool(T) PlugTool(U) Language(A) Help(E) Lock(Q)

ERISIE)IC - g [

—_4 Screen1
ElE: - flAOE X Iy i ® « -C
o | Name |
1 v S g | ‘ 1 j &
g Name: | Tulips.jpg
%Y 0,0 [Fu Y

Wil 200x200

@)
CIRCY
@

“ Play duration }

m

0 S Hour 0 [ Min |5 |5 Sec

7 Play Segment =] [ Play effect |
o
o =
a Specific date Has effect
o
£ startDate EndDate Spest:
= 2014 sANA v 2014 sANA v -] . e
o
% 20144 8812 20144 8812 |
& 4F 8A128 v 4F 8F128 ¥ B Backgroun... B b
=1 20145 8H13H v 2014F 88138 ~ E] -
ransparen... al »
100%
20144 8H14H v 2014F sH14H v E] -
{ Border}

Fig.2-49 Priority program of the page
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2.2.1 Toolbar

Play according to Switch between showing
Open program Save program  Scheduled date  Stop play or hiding the screen Program edit homepage

[ HEO® - 4

_

Create a priority program 5ave program Preview from the Pause Edit List at any time Switch tomini  View Scheduled date,
of the time segment or current page during play process, screenmode andclick “Program edit homepage”
a priority program of the and then click the to return to the edit window
page button to refresh to
the latest

2.2.2 Edit play program

The edit homepage of Program is divided into multiple windows, and each window is

named according to its function, as shown in the following figure.

B e e e s @ s s - = . — ;LI & - T
Schedule(P) Control{C}  Settingz(S) View(V) Tool(T} PlugToollU) Language(&) Help(E} Lock(O)

ERN=[E0IC Y
350reen1
T WOk X I 4o = -C

{ Name } -pz
Name:  EHLEEH ‘ 3
——————| Play duration | ———————— ‘3'
o
0 i Hour 0 [ Min |5 |5 Sec E
i H
(& ™ Play and media attriLute
| Play Segment Iayout window =] . X
= Page adding media ||| [##* iz - =
15 @ spectc aste 8 r © edit window
E Start Date End Date window § E
g: 2014F 8H11A v 2014F e 1A « B (Boaraer]
» 0145 8H12H - 2014F 8120 B
| 20148 8H130 » 2014F 88130 B . -”UL
review
— | BackGround |———————————
Scheduled window ow (— e
@ [Stretch i
Fig.2-50 Page function distribution
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1) Display Setting
Click “Control” — “Display Setting” to set play window.
ooy Seting S =5

Count of Display -
Screen: b = Update
Screen’

Name: Screent
StartX}:  [p = | Width: 200 =
Starty: |0 | Height: 200 5
On Top: ) Never

@ Playing

[] Show Screen(Shift+H)

[] Lock Screen(Shift+L)

Mote:After the =creen is locked, it is unable to uze the
mouse to change the screen size and position.

[ Ok ] | Cancel |

S T

Fig.2-51 Display Setting

2) Page adding or deleting, sorting, layout window

8

Click & to add the page, select Page Layout at the drop-down box at the right of the

screen, and amend the proportion by clicking the buttons Up, Down, Left and Right based

on requirements.
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S5 | |

Select page
layout

i/
I
I
I
I

td

Fig.2-52 Page adding or deleting, sorting, layout window

3) Page adding media window

Select one window of the page, and then click button on the toolbar to add media to the

window.

Click Q to simulate the real display screen to view the distribution situation of pixels.

Add countdown

Add text Add analog clock Add weather report

‘ ‘ cl‘ock
I | [ [
200 } | G‘l I
Add media file Add digital clock  Add temperature and Amplify the screen to view
(pic./video/text/word etc) humidity display pixels
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Fig.2-53 Page adding media window
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@ X | Q= IQ

4 1 |

Fig.2-54 Screen after 3 times of amplification

4) Play and media attribute edit window

When adding the media, simultaneously set attribute of the media and the play effect at
the window.

5) Page review window

After finishing page editing, randomly select one page to preview the display effect of the
page in the preview window.

6) Scheduled window

a) Check "Scheduled date" to set play date of list, and cIickE]to increase or

decrease the time.
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< Play Segment E

Specific date

Start Date End Date
D April27,2014 w  April27,2014 E]

I April28,2014 * I April28,2014 ¥

IWeek day I Time "E‘

&)

Fig.2-55 Set Scheduled date

b) Click "TIME" to set the play time of List, available options are All day, point-in-point
or Time slot.
When "Point-in-point”" play is selected, click to select the point-in-time, double click to
cancel; the default is to play for one hour from the selected point in time; for example,
three points-in-time are selected in the following figure - 12 AM, 3 AM and 8 AM; then the
play scheduled dates are:

Play from 12 AM to 1 AM; Play from 3 AM to 4 AM; Play from 8 AM to 9 AM.
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Play Segment E
& _ _ _
rg ) Al Day @ Time point () Time segment
[IE]
= 12400 AM 240 340 480 S M
)
=
] &AM TAM 3 4M S AM 10 AM 11 AM
[E]
=
2ZPM P ZPM IPM 4PM SPM
EPM TPM 2PM gPM PM PM
[ Selectal

Fig.2-56 Set Point-in-time

When "Time slot" play is selected, click Bto increase or decrease the time segments.

Play Segment ] [w]
n ~ A _
2 () Al Day (1 Time point @ Time segment
[IE] . .
E Start Time End Time
y 07:00:00 =l 08:00:00 n B
o
© 08:00:00 2| 09:00:00 4 B
=
['F]
[E]
&\ 09:00:00 2| 10:00:00 & B

Fig.2-57 Set Time slot

c) Click "Week day" to set the day in the week to play List.

Phone: NovaStar (Xi’ an) 86-29-84507048 NovaStar (Shenzhen) 86-755-33592492

Website:www.novastar-led.com




Nav,ysrAn

NovaStar Tech Co.,Ltd

[w]
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i
g Thursday

[ Saturday
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Wednesday

Friday

Fig.2-58 Set weekday

d) View Scheduled date

o=y
Click 25" to view the Scheduled date.

=

Schedule(P)  ControliC)  Seftings(S)  View(V) Tool(T)

- EEO®

Plug Toel(U}  Langua
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" 12 1 2 3 4 5 [:3 T 3 9 10 " 12 10 11
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T LI/

Fig.2-59 View Scheduled date by day
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Fig.2-61 View Scheduled date by time segment
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3 Immediate Notification

The Immediate Notification is for publishing notifications during the play process of a play

program. Click menu item Notification under Control menu, the Immediate Notification

control window will show as in Fig.3-1.

4/ Notification Control = =] X ],_
Hotification List
Index Screen Status FPlay Information Loacation®Size Content
Add Modi £y Delete Flay Stop Stop All

Notification Error

Fig.3-1 Notification control window
> Add a notification

A notification needs to be added to the notification list before it is played. Click Add button

to access the Add Notification dialog as shown in Fig.3-2.
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Add Notification @
Screen: [All Screens v]
FPosition
Left: 0 4 <=200 Width: (2000 - <=400
Top: [0 =] ¢=275 Height: 20 2] <=pes5
Flay Type -
Cycle Times ? v
@ Duration 0 3— Hour;w ":“ Min 0 r‘:" Sec
Media Type
Scrollmg ~ Single Line - : @ Complex
© Text " Text O Static;Taxt ! Text
Property |Text
Back: | Stretch \s . |

Back Transparent [] Text Effect | buspens1 on v

Font: Calibri, 12pt s = o s\ [E

[7] Cycle Interval of Cycles: 10 o 'Pixel
Go speed: [3 (Hormal) ']
Duration: 0 }{our 10 ‘34, Min :0 w':' Sec

I Add ’ | Cancel ’

Fig.3-2 Add Notification dialog

Properties of a notification such as display screen, position, play type, media type and
content can be set through this Add Notification page. Click Add to add the edited

notification to the list. Shown in Fig.3-3 is a notification in the notification list.

Hotification List

Index Screen Status FPlay Information Loacation®Size Content

0,0, 200, 20 ‘hello! Power will be off!

Sereenl

Fig.3-3 The notification list

> Show Notifications
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To show a notification on the LED display, select it form the notification list and click Play
button. The play status of this notification will became green from gray. And the play
information of this notification will also be shown in the Notification List panel. Shown in

Fig.3-4 and Fig.3-5 is an example for notifications being played.

Hotification List

Loacation®Size Content

@ |0:0:200:20°  iWotice:Bower -
% [0,0,200,20  Totice:Power ..

2 Secreenl () Played Times:1, Remaining Times:2 |20, 20, 200, 20 Hotice:There ...

Fig.3-4 Notifications in the list

Notice:Power will off!

Notice:There 1s error inform,

—

12/19

Fig.3-5 Notifications shown on the LED display

Use the Stop button to stop showing the selected notification. The Stop All button is for

stopping all the notifications being shown.

To modify a notification in the list, select it and click Modify. Note that notifications being
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shown are not modifiable.
Use the Delete button to delete a selected modification.

Messages will be shown in the Notification Error panel if any error occurs during the play

process of the notifications.
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4 Emergency Inserted Play

In the situation that certain media or play program needs to be shown or play urgently, use
the Emergency Inserted Play to pause the current playing and start the urgent play. Click
menu item Emergency Inserted Play under Control menu, the Emergency Inserted Play

Control window will show as in Fig.4-1.

i) Emergency Insert Play Control —

— —
Secreenl l»

Current Information of Insert Play

Type: @ File ) Play Program
Methods: Q@ Immediate

() Delay Hour © Min 10 - Sec
Duration: 0 % Hour © S Min 90 5 Sec

Flay Error

) ]

Fig.4-1 Emergency inserted play control window

1) Emergency play of media files

Select File from the Emergency Play interface as shown in Fig.4-1 and click Browse. On the

pup up dialog, as shown in Fig.4-2, select the media file to be played. It could be a file of
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media type of video, Flash, audio, picture or any other type supported by NovaStudio plus.
Properties of playing that is how the selected files are to be played should be set as well,
such as background color, background picture, transparency, scale, volume, position and
duration. After all these settings, click Ok to finish setting.

Please select the inserted files lgi

File Path

E:\oppo. AVI

File Property

Path: E:%oppo. AVI

Back: [. v][Stretf.‘h v} D
Transparency b 100%
Seale: |Fill -

¥olumn: {] 100 E]
Position: 00:00:00

Duration: 00:00:15. 151

) (Lomea)

Fig.4-2 File setting dialog for Emergency Inserted Play

Before begins the emergency play, Methods of playing need to be specified. Select
Immediate to start emergency play immediately. And emergency play will be postponed
for the time set for duration if Duration is selected. Click Start to active emergency play.

Examples for immediate and postponed emergency play are shown in Fig.4-3 and Fig.4-4.
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&1 Emergency Insert Play Control bl L nctl

Sereenl

Current Information of Insert Play

. It is playing inserted content!
Remaining Time:0:0:42

Type: @) File Play Program
E: \oppo.;&ﬁd

Methods: @) Immediate

1l ST o Ta)
Delay |0 | Hour 0 v ‘ Min ‘10 1| Sec
— =

Duration: 0o s } Hour |0

L

Start | [ FPause ] [ Stop ]

Flay Error

Fig.4-3 Immediate emergency play

i) Emergency Insert Play Control l = | |

Screenl

Current Information of Insert Flay

('\7“ Inserted content will be played ......

5) Remaining Time:0:0:5

Type: @) File Flay Program
E:hoppo. AVI

Methods: Immediate

@) Delay ‘D : EHour;D fl'ﬂin ’10 $ iSec

Duration: 0 3 i}{our‘;D Min lSU = iSec

Start [ Pause ][ Stop ]

Flay Error

&3

Fig.4-4 Postponed emergency play
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2) Emergency of play program

Select Play Program from the Emergency Play page and click buttonL, on the pup up

dialog, as shown in Fig.4-5, select the play program file to be played. If the play program

has multiple segments, you must choose one of them to play.

Please select play program

Path:

E:\l.plym

Please select one segment:

2
(W

Name

1 [Segment 1]
2 [Segment 2]

0K

| e

Fig.4-5 Choose play segment of play program
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5 Monitoring

When display screen is in display state, real-time playing of play window of the display

screen can be monitored through this function. The specific operation is shown in the

following:

Click "view" —>"monitoring" to open the monitoring window.

Note: If and only if the monitoring check box is selected under the playing state, the play

window will be monitored; otherwise, the monitoring window is blank screen. Current

playing picture is displayed in the monitoring window.

Schedule(P)  Control(C)  Seftings(S)  View(¥) Tool(T) Plug Tool(l) Language(d)  Help(E)

- EEC00 6" 4

A Screent [m

Current Common Segment:  General Segment! [2014/12/2 0:00:00 To 2014/12/3 0:00:00] Playing

Mext Common Seament(n ... onoro) Seqmentt (201441273 0:00:00 To 20144 264 0:00:00]

Play Info o
..Global Page a5 Monitor

=--Common Page(Page1) Sti
(=~ Common Window1 (0,0l
-~Current Media: Chri

L Next Media: Chrysi

Screent Monitor  Screen2

Monitor all

Refreshing pe... |1 IJU|

Monitor

Play Error =——

ol

Mew Schedule
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85 Monitor '&‘Eﬂ

Maximum number of horizontal display: 3

Ve
'

-
.

V| Monitor all Refreshing pe... 10| ™ ey

Fig. 5-1 Monitoring window

6 Remote Display Screen Management

Remote control of one or more display screens is realized through a control computer. This

computer is collectively referred to as “control computer” in the context.
6.1 Preparations
1) Run NovaStudio plus on the playing computer corresponding to the display screen;

2) Click menu “Settings” — “Network Settings” . “Remote Real-time Management”

must be ticked off first.

3) Select the IP being monitored currently, i.e. the corresponding IP on the local computer,
and set communication port, which can be set within the scope of 1025~65535 and

can not conflict with other communication ports.
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4) Connection password is optional. In case of connection password, the same password
must be input when adding display screens to let MCC control such display screens
remotely. Or failure.

5) After setting, click "OK" .

-

Hetwork Settings X

Eemote Real-time Management

Listen IF: |19Z. 183 0. 162 w | Fort: 12885

Fig.6-1 Network Setting

6.2 Add Display Screen

Run NovaStudio plus on the control computer.

1) Click the menu bar “Control” — “Remote Screen Management” to enter the interface

below:
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ol FEemote Screen Management = X

Sereenn Contral

: & D)

Seoreen List: E]
Statuz | Hame Indax Hat

Moo

Fig.6-2 Remote Display Screen Management

2) Click W5 to add remote display screen, fill the name, number, IP (IP on the playing

computer corresponding to the display screen) and port (must conform to the
communication port of the network set on the playing computer previously) of the
display screen to be added in the interface below, in case of connection password to
remote display screen, input the same connection password, and click “OK” upon

completion.
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Add Screen

Screen Name:

Screen Index:

IP:

Port:

Star
1

192 . 168 . 0 . 156

12888

|| Connect Password:

l Add

‘ Cancel ]

Fig.6-3 Add Remote Display Screen

3) The display screen added interface is shown as below:

.

gt Eemote Screen Management

Sereen  Comtrol

. &) S 9 (D

Screen List:

| & | |

Status | Hame Index

Het

LN I

Fig.6-4 List of Remote Display Screens

4) Multiple display screens can be added as per the steps above.

Phone: NovaStar (Xi’ an) 86-29-84507048
Website:www.novastar-led.com

NovaStar (Shenzhen) 86-755-33592492



NOVASTAR NovaStar Tech Co.,Ltd

6.3 Send Programs/Files
Send programs or files to display screens in long range via control computer.

1) Send programs

)
a) Click * 1" to enter the “send programs” interface. Click [: to skim through

the path where the playing programs are and open it.

Send File. .. ... = X

Sending Flay Frogram:
C:hDocuments and SettingshAdministratoriMy Dncments"xﬂnvaﬂtudinEDlE"ang"xFD

Advanced Setting

Last l Hext l l Exit l

Fig.6-5 Send Programs

Advanced Setting : set the local storage location of files on the playing computer
corresponding to the display screen, or the programs will be saved at the default path.

Users can fill in the suitable storage path at discretion.
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P -

Send File. ... .. = X

Sending Play Program:

| ingshhdministrator My Document =" HowaStndi 02012\ Log i FlayLogiSereend i1,

The =torage location of the filesz in the play computer:
|<I|ef=ault> v|

Fig.6-6 Program Saving Path

b) Click “Next” , tick off the target display screen in the page and send programs to it.

r !
Send File. ... .. = x
Flease select the =ereen:
Statuz | Hame Index Het
g NS
All
’ Lazt ] [ Hext l ’ Exit ]

Fig.6-7 Select Target Display Screen

c) Click “Next” to view the list of display screens to which programs to be sent. Go

back to “Last” in case of changes.
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r 1

Send File. ... .. = X

Sending Screen List:

Statu| Hame Index Het Process Reszult

M star 1 192, 163.0. .. 0. 00%

[ [ ][ = ]

Fig.6-8 Display Screen Sending List

d) Click “Send” , and the software will pop out prompts. Click “OK” to start sending.
Upon the completion of sending, and select sending at background during the

sending process.
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Send File...... =\ X

Sending Screen List:

Status| MWame Index MNet Process Result

™ | star 1 152.168.0.162(... 35.37%

Background Send Last Send

Sending Screen List:

Ztatn Hame Index Het Frocess Fezult

M ctar 1 192 1650 .. 100, 0o% Succeed! ~

[ | [(neea [ B |

Fig.6-9Sending Completed

As shown in interfaces of Fig.6-9 playing programs can be resent to display screen either by

clicking the button ““* " corresponding to the display screen or by clicking the “Resend ”
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beneath the interface.

2) Send files

‘ﬁ
Click "4 to enter file sending interface:

4

Send File. ... .. =

Sending File List:
1 C:'Documents and SettingshAdminiztrator'My DocumentshMy Picturesh. ..

z C:'\Documents and SettingsiAdministratoriMy DocumentshMy Ficturesh. ..

()] (4]

Advanced Setting

Last ’ Hext ] ’ Exat ]

Fig.6-10 Send Files
[ Add files
%] : Delete files
&] Empty the listed files

Advance Setting : set the local storage location of files on the playing computer
corresponding to the display screen, or the programs will be saved at the default path.

Users can fill in the suitable storage path at discretion.
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o
J

Send File......

Sending File List:

1 DADocuments and Settings\AdministratoriMy Documents\My Music\Because Of 25....
2 DADocumentz and Settings\AdministratoriMy Documents\My Videos\Because of 25..

()] (4]

The storage location of the files in the play computer:

v]

Last ’ Mext ] l Exit ]

Fig.6-11 Send File Advanced Setting

Click “Next” to send files. The following steps are the same with those of program

sending.

TIP:

If a media playback program involves many media files or those media files

are large in size, it may take a long time to send out the playback program.

For that kind of cases, the following steps are recommended.

@ 1. Send the media files to the target computer in advance. Make sure in the
target computer, the saving path of the media files is the same as that
they are saved in the computer from which they are sent out.

2. Make the media playback program in advance.

3. Send the playback program to the target computer and save it to the

Phone: NovaStar (Xi’ an) 86-29-84507048 NovaStar (Shenzhen) 86-755-33592492

Website:www.novastar-led.com




NDOVASTAR

NovaStar Tech Co.,Ltd

finished.

folder where the media files are in. As the media files are already there,

the playback program is ready to work once the sending process is

6.4 Send the Order

Click " > to enter order control interface. One or more display screens can be ticked

off to send control orders for it.

Send Command

Pleaze =elect the screen:

]
4

Status Name Index Net
| & |

Result

Al

EmreaaeE

Fig.6-12 Order Control

Timing: network timing, time synchronization

Play: start playing

Pause: a pause in current playing
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Stop: stop current playing

6.5 Timing

Network timing can be performed to all the display screens in a long range. Immediate

timing and periodical timing can be set. Refer to2) network timing of Chapter 10 for the

specific operations.

6.6 Acquire Screenshot

Refresh and acquire desktop screenshot of displaying computer corresponding to remote

display screen.

ot Screen Imformation. .. = X

Horizontal Maximum Screen Count: |1 A

Playing:

< ; S

Get Image Refresh Al ] [ Refresh Selected Exit

End Getting

Fig.6-13 Get Screenshot
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6.7 Send Notice

Send instant notice to remote display screen. Location, play mode, play duration, media

type and attributes of notices are settable on display screen.

Send Motification

Location
{:) Full Screen

Left Or Right
'E} Top Or Bottom | Top

Play Mode
Loop Timez

'E} Play Duration 0

Media Type

Single Line
& ScrollTet () —

Text | Property

helio?

4

+ | Height: 20

10 5| Min |0 % | sec

(3] (<]

Fig.6-14 Send Notice

6.8 Send Emergent Inserted Play

Send emergent inserted play file to remote display screen and play the inserted play file

immediately upon completion.
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Send Emergency Insert Play

Current Ingert Play Status

Insert Play

Type: File

Play Duration: |D :lHuur |D

=
vll'u'lm

0 3| sec

w =] (=]

Pleaseselecttheinserted files x
File Path
D:ADocuments and Settings\Adminiztratoriily Documentsi\Wy |
File Property
Path: |D:1Duu:u ments and Settings\AdministratoriMy DocumentziMy ‘-.-"'H:Iet|
Back: [I v]| Stretch W | ":]
Transparency: 100%
Scale: | Fill w |
Volume: J 100 @
Position: 00:00:00
Duration: 00:03:20 968 [] Owverlay Text Edit Text
| 0K | | Cancel |
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-

Send Emergency Insert Play - ™=

Current Inzert Play Status

Inzert Play §

Type: File
D:\Documents and Settings\Adminiztratorily Documentz\My Videos\Because of
25—Tai.mp4

Play Duration: (0 % (Hour (0 % | Min [0 |2 | Sec

o ] (o]

Fig.6-15 Send Emergent Inserted play

7 Settings

7.1 Display Window Setting

Display window setting is used to set the mapping relation between the control computer
(display) and the LED displays that is managed by NovaStudio plus. Select Setting
->Display Setting from the main menu of NovaStudio plus to access the Display Window
Setting dialog which is as in Fig.7-1. Display window showing/locking can also be

enable/disabled through this dialog.
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Display Setting

Count of Display |2 ~ -
Screen: |~ v Update

| Sereenl |Screen?

Hame: fScreenl
Start ¥:[1144 S| Width: [320 %
Start Y: 78 e ene 112 $

Top Most: O Never
(%) Playing
Show Screen (Shift+H)
[] Lock Sereen (Shift+L)
Hote:Once the display screen is locked,

it is unable to use the mouse to change
the screen size and position.

[ ox [ coca |

Fig.7-1 The Display Window Setting dialog

To add or delete LED displays to/from NovaStudio plus, enter the new LED display count
and then click the Update button. NovaStudio plus will regenerate the display windows
according to the new count. (Note that the physical relation between the control computer
and the LED displays are set by NovalCT or other similar software applications.) Set the
parameters for the display windows according to the LED displays parameters and then

click OK to complete display window setting.

7.2 Start Setting

Start setting is for NovaStudio plus to start up automatically and begin playing certain
playlist or activate certain schedule after the computer starts up. To access the Start Setting

dialog, Select Setting ->Start Setting from the main menu of NovaStudio plus. The Start
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Setting dialog is as shown in Fig.7-2.

Start setting

[] Auto Run

|| Restart Software on Time
Restart time: 22:34:00 2

(V] Auto Flay

I Secreenl ‘

Every 1 2| days, restart software for once.

C:'\UsershstariDesktophl. pgst

FPlease browse one play program file.

["] USB Disk Play

Fig.7-2 The Start Setting dialog

(o)

If Auto Run is selected, NovaStudio plus will start automatically after the computer starts

up.

If Restart Software on Time is selected and time for restart is set, NovaStudio plus will

restart automatically when the computer time reaches the set restart time. And NovaStudio

plus will also recover the status what it was in before the restart. The restart function is

useful in helping NovaStudio plus to run stably for long time. In some cases, the computers

are not allow to shut down, thus NovaStudio plus may become less stable due to problems

from the OS, decoders or others in long term running. Restarting NovaStudo2012 when it

is idle can keep NovaStudio plus in good status.

If Auto Play is selected, NovaStudio plus will activate the specified play program file
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automatically after it starts up.

Note that OK should be clicked after setting to activate all settings.

7.3 Play Setting

Select Setting ->Play Setting form the main menu of NovaStudio plus to open the Play

Setting dialog. The Play Setting dialog is as shown in Fig.7-3.

Play Setting
Log Setting Saved Log Path:
FPlay Setting

Log Duration(Days):
3}30 * ‘

[ ] [cmea |

Fig.7-3 The Play Setting dialog (Log Setting page)
7.3.1 Log Setting

NovaStudio plus saves the play information of each media source in play log. And the play
log files are saved in "My Documents\ NovaStudio plus\Log\PlayLog” of the current
computer user. Each LED display has its own folder. The folder name for the Nth LED display

in the LED display list is “ScreenN” .

Note that NovaStudio plus deletes log files that are stored in the hard disk longer the
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number of days specified by Count of Effective Days of Log.

7.3.2 Play Setting

The Play Setting page in the Play Setting dialog is as shown in Fig.7-4.

Play Setting x

| ing |
Log Setting |wl
Enable Preventing Stuck Function for Video
Play Setting . ) .
MWote: When enable the function, if the video screen stuck
during playing, the =oftware can quickly stop the current
video, and switch to play the next media.

Enable draw effects in vertical refres...

Wote: When enable the function, the CPU utilization
increazes when picture effectz iz playing ; if the picture
effects do not move or change in the vertical dirgction,
you may dizable this function;

[] Mormal Video Rendering Mode

MNaote: If the graphics card configuration of computer iz
lowi{memory is less than 512M), use this mode to reduce
rezource utilization, but transparent text would flash
when overlayed on the video(software uses advanced
rendering mode by default);

[] Synchronize play media by time.

o | [ |

Fig.7-4 The Play Setting page
< Video Stuck Prevention

Due to problems from decoders or computers, video could be stuck during being played.
NovaStudio plus monitors the video when it is being played. If a frame is being shown for

too long, NovaStudio plus will stop playing this video and switch to the next media source.

< Draw Effects in Vertical Refresh Synchronization

Vertical effects for pictures, such as wiping in horizontal (from left to right or from right to
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left), may encounter the problem of slit and dislocation when they are applied on large
pictures, as shown in Fig.7-5. The function of Draw Effects in Vertical Refresh
Synchronization helps to prevent slit and dislocation and also smooth the vertical effects.
However, this function increases the CPU utilization. Choice of whether to enable this
function or not should be made based of the situation. Normally, this function need not to
be enabled if the picture is not large or the effect does not involve vertical synchronization,

such as wiping in vertical and fading.

e

n!ga!!g;!,."

Fig.7-5 A slit and dislocated picture

< Normal Video Rendering Mode

NovaStudio plus adopts the advanced rendering mode for video rendering as default. If the
computer is relatively low in performance, enable the Normal Video Rending Mode.
Normal video rending mode also helps to prevent the problem of slit and dislocation in

quick motion pictures,

< While playing, synchronize media as per the time:

After this option is ticked off, the software will enable the synchronic playing of playing

programs according to the computer time. Please refer to 11 Synchronic Playing Function

for the specific operating steps.
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7.3.3 Preview Setting of Media

Click “Settings” — “Preview Setting of Media” on the toolbar to enter the media setting

interface shown as below:

o5 Preview setting of media b 4
[Preview Setting |-

When click to preview (@ only play one time.

media,
loop play.

@) black screen.

When preview

finished,
) keep last frame.

Fig.7-6 Preview setting of media

The user can set media clicking preview at “only play one time” or “loop play”
according to the practical demands. If “only play one time” is chosen, “black screen” or
"keep the last frame” may be selected upon the completion of media preview setting

with the options below.

8 Computer Locking

To prevent unauthorized operations on NovaStudio plus, NovaStudio plus is capable of

locking the computer by disable the keyboard and the mouse.

< Set/Reset the password
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Select Set ->Password Setting from the main menu of NovaStudio plus to access the

dialog for password setting, as shown in Fig.8-1.

Password Setting @

Change password

01d Password: \l ; \_

New Password: ‘ ‘

Confirm new ‘ \
password: = "

T

Fig.8-1 Password Setting dialog

TIP:

The initial password is NULL. That is there is no initial password!

< Lock the computer

Select Lock(O) at the main menu of NovaStudio plus to open the confirm dialog for

computer locking, as shown in Fig.8-2 and Fig.8-3.
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Play Program(P) Control(C) Settings(S) View(V) Tool(T) Plug Tool(U) Language(A)
Help(E)
GaHKRPIE & '8

T.. Screenl
1oy Proran | )

[I] o an ..;\:f:), 57

Date Range of Schedule

- TICE@ . COITE

f ez 1
b L LAy

The latter segment has higher priority in the same type.

About
@ Show window name and Priority: The timing inserted segment has higher priority than the
index cycle inserted one.
New Play Program

Fig.8-2 Lock(O) in the main menu

Sure to Lock @

9 Sure to lock computer?

Tips: 1.After Locked, keyboard and mouse are disabled.

2. Press 'ESC’ key and enter password to unlock.

3.The initial password is empty, you can change the current password
through ’set’ - “lock set’.

Fig.8-3 Confirm dialog for computer locking

® Read the messages in the confirm dialog for computer locking carefully before

lock the computer.
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® C(lick OK to lock the computer. All keys except for the ESC key will be disabled.

® Press ESC to access the unlock dialog. Password is required for unlocking the

computer.

® A message as shown in Fig.8-4 will be shown when the mouse is moved.

Keyboard and mouse have been locked, please press the ESC’ key to enter enter password to unlock.

Fig.8-4 Message shown when the computer is locked

® The Lock(O) item at the main menu of NovaStudio plus is red when the computer

is locked.

TIP:

:ﬂ% The computer will always be in the lock status after it is locked, even
b
NovaStudio plus is restarted (auto starts or by double clicking the .exe) by

computer restarting by force. Password is the only way to unlock it!

< Unlock the computer

Press ESC to open the Unlock Window for unlocking. The Unlock Window is as shown in

Fig.8-5.
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Unlock ¥Window £3)

Unlock Password

BackSpace (%)

Random Code:585314540

Press “Enter’ when finish entering.

Press "Esc’ to exit unlocking.

Fig.8-5 The dialog for unlocking

Type in the password and press Enter to unlock the computer. Press ESC to exit unlock

process.

TIP:

H If the password is never set or is set to be NULL, press Enter key directly to
h.

unlock the computer.

Please contact us if the password is lost.

9 Disk Play

1) Export Play Program to USB Disk

The playing programs on control computer must be exported to USB flash disk. The
playing programs and the media involved can be exported to the designated folder on USB

flash disk through the “export to USB flash disk” function of playing programs.

Click the menu item “export to USB flash disk” under the menu “playing programs” , as
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shown in Fig.9-1. Select USB flash disk in the dialog box popped out, and set the name of
backup folder, at where the media to be saved after being exported to USB flash disk. For

the avoidance of repetition, a prefix to be attached in case of name duplication shall be set.

" ut

Export ta USE Dizk x

Select USE Disl:
G:h “
Exported folder name:

D1 =kFrogramFolder

When the file name is the zame as the
existing file, add prefix to awveid

TIew—

The MAC address of play computer:

10-T8-D2-25-5F-41 IE
22-54-3E-25-A0-11

(o ] [ ]

Fig.9-1 Export to USB Flash Disk

Click &J to add the MAC address of the computer where the program will be played.

More than one MACs can be added.

Click "OK" upon the completion of setting. Then, the interface below will pop out:

Baclp successfully!

Fig.9-2 Export USB Flash Disk Successfully
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2) Enable USB Disk Play

NovaStudio plus in the play computer needs to enable USB Disk Play function. Click Start
Setting under Setting menu, as shown in Fig.9-3. Select USB Disk Play, and then click OK,

as shown in Fig.9-4.

BT I

ey g e

Play Program(P)  Control(C) | Settings(S) | View(V) Tool(T) Plug Tool(U) Language(A)

Help(E) Lock(O) Display Setting(S)
O &K PO - Start Setting(A) |
. 7m‘— Play Setting(P)
y = Lock Setting(L) [ditingArea |

E\w Play Program 7,,%l

I Background play(B) OO0 0OO
Hide all windows(H)

Name? Fagel

Fig.9-3 Start Setting menu item

Start setting @

[] Auto Run

Restart Software on Time

Every 1 A-{" days, restart software for once.

'

-

Restart time: 22:34:00 =2

(V] Auto Flay

Screenl_i

Please browse one play program file.

C:\Usershstar\Desktopil. pgst [:]

[V] USB Disk Flay

Fig.9-4 Enable USB Disk Play

After enable USB Disk Play, if the USB disk which has backup content is inserted,

NovaStudio plus will detect it real time and play the play program on it at once; If the USB
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disk is removed, the play will be stopped.

If USB Disk Play is selected, and the auto play file when NovaStudio plus started is not set,
NovaStudio plus would detect the USB disk of the current computer and play the play

program file on it (If has) when started.

10 Backup

NovaStudio plus provides backup functions, and users can backup programs to hard disk

or mobile storage device in time.

Click Backup under Play Program menu, as shown in Figl0-1. In the pop up dialog, set the
backup path as the root path of USB disk (here must be the root disk) , set the backup
folder name arbitrarily, as shown in Fig.10-2. After click OK, the backup process will be

shown as Fig.10-3. A message will be shown as Fig.10-4 when backup finished.

Play Program(P) | Control(C) Settings(S) View(V) Tool(T) Plug Tool(U) Language(A)
New(N)
Open(O)
Save(S)
Save As(A)

=

f”l’layl’rogtanlditinghrea" ‘

Backup(B) [ »

Recent Play Program(R) » | Range of Schedule |

Fig.10-1 Backup menu item
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Select the backup path

Select the backup path:

T\

Backup folder name:
FlaylistBackup

fhen the file name is the same
as the existing file, add
prefix to avoid repeation:

new—

| [pomeal

0K

[

Fig.10-2 backup setting

- - v s

Bm Play Program
Ej@ Segment 1

ol
o

Play Program(P) Control(C) Settings(S) View(V) Tool(T) Plug Tool(U) Language(A)
Help(E) Lock(O)
‘O HR DI D+ 2
? Sereenl
{Page Editing Area |

O-B2etdX» QOO OO0

Name: Pagel
Flay Type: [Cycle 'J
Pley 00:06:00 - Pley Times: |1

Duration:

{ ' it’s backing up media:oppo. AVI
o®

]

? Screenl

image:
g;:le:::tay [Stretch v]
Back Music: - X f ‘ b h
[ ]
Fig.10-3 Backup process
Play Program(P) Control(C) Settings(S) View(V) Tool(T) Plug Tool(U) Language(A)
Help(E) Lock(O)
ACE S SR BE 3k |

E]w Play Program
££) Segment 1

im
o B

{Page Editing Area }
3 NN E]

Backup successfully!
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Fig.10-4 Backup finished

11 Synchronal Playing Function

Synchronal playing function is provided in this edition to solve the requirements for
synchronal playing of multiple display screens in some occasions.

1) Enable synchronal playing function

Run NovaStudio plus on the playing computer, click menu “Settings” — “Play Setting” on
the main interface to enter the play setting interface, tick off “synchronize play media by

time” and then click "OK” . The synchronal playing function will be enabled successfully.

Play Setting x

[Play Setting |
Log Setting |wl
Enable Preventing Stuck Function for Video
Flay Setting
MNote: When enable the function, if the video =creen stuck
during playing, the zoftware can quickly =top the current
video, and =witch to play the next media.

Enable draw effects in vertical refres...

Mote: When enable the function, the CPU utilization
increazes when picture effectz iz playing ; if the picture
effectz do not move or change in the vertical direction,
vou may dizable this function;

[] Normal Video Rendering Mode

Mote: If the graphics card configuration of computer iz
low {memory iz less than 512M), use this mode to reduce
rezource utilization, but transparent text would flazh
when overlayed on the video(zoftware uzes advanced
rendering mode by default),

[] Synchronize play media by time.

o | [ |

Fig.11-1 Play Setting

Q Caution:
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As synchronal media function calculates the media playing time by time,
so as to achieve the synchronal playing of multiple display screens, the
time on multiple playing computers must be the same. This software
achieves time synchronization by network timing. See the operating

steps in 2) Network Timing of this section.

2) Network timing

There are two methods for network timing. Method 1 is to operate on each playing

computer respectively, and perform network timing by acquiring time from network. It

takes too much time. Therefore, method 2 is recommended (under the premise that

remote control is built), as it is convenient and more accurate.

Method 1:

Set the NovaStudio plus on the playing computer corresponding to each display screen.

a) Click “Settings” — "“Get Time From Internet” on the menu bar, and then click “Set
Time Now” in the dialog box popped out. The system will acquire network time

immediately.
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Set Time How 0K | Cancel |

Set time succeed!

Fig.11-2 Immediate Timing

b) Tick off "Auto Get” to set the timing cycle and then click "OK" . The playing

computer will conduct timing regularly according to the cycle after that.

” !
Get Time From Internet x

Auto Get

Feriaod: = % | Minutes

Set Time How l ’ 0K l l Cancel l

Fig.11-3 Periodic Timing
Method 2:

If remote control is set up on multiple computers, just operate on NovaStudio plus on the

master computer.

.: L—_
Click " & (timing)"” on the toolbar, the interface shown as Figure1l1-3 will pop out. The

operating steps of method 1 must be repeated.

{SH TIP:
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Uniform timing will be performed to all the playing computers connected to all

the master computers.

12 Display temperature and humidity

If the system is equipped with temperature and humidity probe, temperature-humidity
media widow can be added on the display screen to display real-time temperature and
humidity.

Click "Setting” — “Setting of temperature and humidity sensor” on the main menu to
enter the window below, where temperature and humidity sensor can be set according to

physical circumstances and then click “Ok” .

ol Setting of Temperatureand Humidit... 3¢

{E} Connected to Function Card on CATS

COM Name: | cope w
Sending Card Index: |1 %
Port Index: (1 b

Function Card Index: |1 =
Connect Index: [1 b

{:} Connected to Function Card on COM

Fig.12-1 Setting of temperature and Humidity Probe

Then the temperature-humidity display can be added on the general window; see 2.3.5
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Media Editing.

Fig.12-2 Temperature and Humidity Window

13 Record Control

This function coordinates with the media recorder of PMM300 under the mode without
sending card and the mode of asynchronous card; it only supports time priority program.
Under the mode without sending card, reticule is used to directly connect the Gigabit
internet access of the computer and Gigabit internet access of PMM300; and computer can
be used to control PMM300 for synchronous display.

Under the mode of asynchronous card, the content which needs to be displayed will be
recorded into the memory of PMM300 under the mode without sending card; when the
reticule between the computer and PMM300 is disconnected, PMM300 can automatically
play the recorded content.

See the following chapters for detailed operation instruction.
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13.1 Add media

On the main interface of the software NovaStudio plus, click "Setting"—"Display setting" to

set start position, and width and height of the screen.

i -
Display Setting ﬁ

Count of Display -

Screen: b = Update

Screen’
Name: Screent
StartX: |0 S width: 200 5
Starty: |0 = | Height: 200 e
On Top: ) Never

@ Playing

Show Screen({Shift+H)

[] Lock Screen(Shift+L)

Mote:After the =creen is locked, it is unable to uze the
mouse to change the screen size and position.

[ OK l | Cancel |

Fig.13-1 Display setting

In the common window, add the media to be recorded; after that, play or preview it; then,

the content played can be seen on the on-load screen of PM300.
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Fig.13-2 Add media
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13.2 Record Control

Click "Control" — "Record Control" to set screen, time frame, control system, frame

frequency of sending card and recording time length, then click "Record".

= —_ — e E— L - Lo “HJ ]
Schedule(P) | Control(C) | Seftings(S) View(V) ToolT) PugTool(U) Language(A) Help(E) Lock(O)
Play(3) w .
+ A Pause(U} L
-_-_! Screent Stop(T}
— | Window Editing Area |
=] Sched Play All . —
=3 G Pause All x
3L Stop Al
Border Setting
: Refresh
=@ eres 2| width: 200 % Height: (200 |
Play PPT(P) j T a
= ¥4k & 20
Notification(N) i/ E ‘ e
Emergency Inserted Play(E) 1
Remote LED Screen Management(M)
Record Control
(]
Path: C:\Users\Public\Pictures\Sample PicturesiLighthouse.jpg
o [Eomea ] o =
Background M... A E
Transparency: D bo100%
iEffecl  [Random v|seeet: 5 [ 0as
[C] outEffect  |pandom V- Speed: lo1s
l [T r _— .
T— [Fu - | stay 5 B sec
Show window name and
index
| New Schedule
o) Record video control [ S
Display |Sereent ~|
Time segment : [General Segment1 v]
Coritrol system:

[Reattek PCle GBE Family Controller

Sender frame rate:

30 v | HZ
Time Segment Total Time : 00:02:30
Maximum record time 00:48:23.911
fxecard s :3 ':-$;5§Hour 0 SiMin 59 Ssec 0 = Milisecond

(If the mapping size of the sending card is inconsistent with the screen size,
please modify)

Stol R

Result of acquiring the size of the memory space of the receiving card: Succeeded
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a- Record video control (S|
Display [Screem v ]
Time segment : [General Segment1 vJ
gcorrolayslon: |Realtek PCle GBE Family Controller -| [ ¢ ]
Sender frame rate: 30 v | HZ
Time Segment Total Time : 00:02:30
Maximum record time 00:458:23.911
Record time 9 ! Hour 0 S Min 59 SiSec 0 + Milisecond

(If the mapping size of the sending card is inconsistent with the screen size,
please modify)
Record | lm‘
Enabling recording successfully, begin to record! .

e

@ Recording completed!

Fig.13-3 Record Control

13.3 Asynchronous mode of play

After the recording is completed, unplug one end of the cable between PMM300 and the

computer; usually directly unplug the cable at the computer end, the screen will start to

play the recorded media repeatedly.

14 Play Streaming Media

Steaming media are the media that transmit audio, video and multimedia file by steam

mode. The typical characteristic of steaming media is that the continuous audio and video
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information are compacted in the steaming medial players, so that they can be seen as well
as unloaded, with no need to wait for the downloading.

Steaming media server is mainly to transmit video files to client by steam protocol
(RTP/RTSP/, MMS, RTMP, etc.). The software supports steaming media of RTSP, MMS
protocols (that is, mms://..., rtsp://...) to search websites on Internet.

As shown below, adding a steaming medium on the general window only needs to fill the

Internet site in the Url, when the software will immediately load and play the medium.

Schedule(Py  Control{C)  Settings(S) Wiew(V) ToolT}) PugTeollU} Language(d)  Help(E})  Lock(Q})

(O s DT |

3 Secreeni |

| Window Editing Area |

= [ schedule

= ) Segmentt TN S J
“oE rame Borer seng
0 & o 3|wigth: [200 3] Height
O E-BEXY ¢4 2
|T|

Url Address: | mmz:/lofficetv bupt.edu.c

olume: . J 100 E]

Duration: |1 - |HIJLII' |D % |Min |U - |Sec
3 | >
Show window name and
index
New Schedule 2
Fig.14-1 Add Steaming Media
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15 Other Functions

15.1 Resume from fault

NovaStudio plus can restart when serious fault happened. Sometime, NovaStudio plus
would not work normally because of decoder unstable, if error happened, NovaStudio plus

would restart itself and resume the play status.

15.2 PPT Showing

NovaStudio plus does not support adding Microsoft PPT files as media sources into playlist,
but it does provide a tool to convert PPT files into pictures and thus the pictures can be

added into playlists for showing.

Select Plug Tool ->PPT To Bitmap to open the PPT to Bitmap dialog for converting, as
shown in Fig.15-1. The PPT to Bitmap dialog is as shown in Fig.15-2. Select the PPT file to
be converted, set the path for the result bitmaps and click Convert button to perform

conversion.

Schedule(P}  Control(C}  Seftings(5) View(V) ToolT) | Plug ToollU} | Language(A) Help(E}  Lock(O)

@ 5 H IT'! | b' |".\ | "% | PPT to Bitmap ]

? Screen’

Fig.15-1 PPT to Bitmap menu item
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gt! PPT to Bitmap X

PFT Path:
Save Path of Bitmap

Convert | | Exit |

Fig.15-2 The PPT to Bitmap conversion dialog

If the size of the play window does not match that of the converted pictures, there would
be compression and distortion when showing the pictures in the play window. NovaStudio
plus can create PPT files of which the page size can be customized. By setting the page size
the same as that of the play window, compression and distortion can be avoid. To open the
dialog for page size setting and PPT file creating, select Tool ->PPT from the main menu,
as shown in Fig.15-3. Shown in Fig.15-4 is the dialog. The page size can be set the same as
a play window (select Same as the display window size and then specify a display window)
or directly (select Custom Size and enter the values for Width and Height). Microsoft PPT
will be started when Click OK. Opened in Microsoft PPT is a PPT file with page size the same

as the set values.

Schedule(P})  Control(C}  Seftings(S)} View(V) | Tool(T} | PugToellU) Language(A) Help(E) Lock{O}

Q & H Rl | 4 | '@ Painter(D) I
? Screent Word(W)
Excel(E)
= [ schedule

% B4+ 4 | Power Point(P) J

= ":’) =egmentt Dizplay screen test tool(N)
= @] Paget Name: |Commen W i
nmrnnn i : Tool Management ...(M)
OE — X: 0 gl T TV -wr TTHEmht (200 5
0] E-heXY 4+ =
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Fig.15-3 The PPT item in Tool drop-down menu

Page Size Setting X

Pleaze =&t the page size of file:

@' Same ag the dizplay screen gize:

Screen1(200,200)

O Custom Size:

width: | |

Height | |

Fig.15-4 Dialog for PPT page size setting and PPT file creating

Microsoft Word files of certain page size can also be generated in this way. Select

Tool->Word to open the dialog for Word files.

15.3 Tool Management

The function of tool management is provided is NovaStudio plus. Users can link their

usually used tools to NovaStudio plus and thus open the tools through NovaStudio plus.

Select Tool ->Tool Management to open the Add Tool dialog, as shown in Fig 15-5. Shown

in Fig.15-6 is the Add Tool dialog.

Schedule(P}  ControlilC)  Setting=(S) View(V) | Tool(T} | Pug ToolU) Language(”s) Help(E} Lock(O)

PO o R 0| | Painter(D} |
A sereend | Word(W)
Excel(E)

= S:chedule : By @ 4 3 Power Point(P}
=-££) Segmentt i "— J
Dizplay =creen test tool(N)

= Iz' Page1 Mame: |Common W
|:| ‘ Tool Management ...(M})
- 0 x Ty =T PUI 200 o THEmht (200 &
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Fig.15-5 The Tool Management item in the Tool drop-down menu

-

Add Tool X
Tool List
Index Name Path
|
Add l ’ Modify ] ’ Delete ] Exit

Fig.15-6 The Tool Management dialog

Click Add on the Add Tool dialog and in the pup up Tool Operation dialog, specify the
tool to be added (set the path of the .exe file) and set its name for shown in NovaStudio

plus. After that, click Add to perform adding operation.

Tool Operation x
Tool Path: CADocuments and Settings\Adminiztrator, [:]
Tool Hame: lpmsg]|

| Add | | Exit |

Fig.15-7 The Tool Operation dialog

After added, the name of the new added tool will be in the drop-down menu of Tool, as

shown in Fig.15-8. Select this item to open the tool when needed.
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MO VLI T WL A T TN el TR e -

Schedule(P)  ControliC}  Settings(5) View(V) | ToolT} | Plug ToolilU} Language(s) Help(E} Lock(O)

: B LR L parter) |
"4 screent | Word(W)
Excel(E)

= F Schedule

HC e S Power Point(P} ‘
=) Segmenti a

Dizplay screen test tool(M)

=-[d Paget i .
I:l ::ame Cummun‘nf| pmsg | S
: -m Tool Management ...(M}) - -v

m i T 4 B 'E‘ [

Fig.15-8 Tools added

15.4 Log Plat

Select View ->PlayLog to open the LogPlat for media play log, as shown in Fig.15-9. The

LogPlat dialog is as shown in Fig.15-10.

Schedule(P) Control{lC}  Sefting=(S) | View(VW)} | Teol(T} PlugToollU) Language(A) Help(E) Lock{Q}
P @ R e Pyl

"3 screent | View Local MAC

Fig.15-9 The Play Log menu item
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LogPlat - B X
Help Language

= - - =

=] @ [ & |
S M T W T F S
1 2 3 5 B 7
g

i 15:3 12 21118 13 123 12:* Log Path: |D:\Ducuments and Settings\Administrator\ly Documents\No m|
%g %g # B ® A B Current Log 2013-9-4
Date:
Choose the date in the left calendar for browsing different log.
2013811 Clear
gﬁ View Log |§§ Log Statistic
& Al Media
(O specific Media | | : :
Whole Day [ | |m| | =i |
HName Duration Start Time Stop Time Result L
» 00:00:05 15:04:45 15:04:50 Succeed
33433559773389700383.jpg | 00:00:05 15:04:51 15:04:56 Succeed
3343355773359700383 jpg | 00:00:05 15:04:568 15:05:02 Succeed [ Y \
3343355773359700383 jpg | 00:00:05 15:05:02 15:05:08 Succee? A 4
3343355773369700383.jpg | 00:00:05 15:05:08 15:05:13 I_Succe_etl
3343355773369700383.jpg | 00:00:05 15:05:13 15:05:19 A Suc_ceed
3343359773359700383.jpg | 00:00:05 15:08:19 15:05:25 Succeed
3343359773359700383.jpg | 00:00:05 15:05:25 15:05-:31_ Succeed B
3343350773360700383.jpg | 00:00:05 158:05:31 ' 1;05:375 - Succeed )
— v

Load log file;2013-9-4.plylog succeed!

Fig.15-10 The Log Plat dialog

Select a date from the calendar and the media play log of that day will be shown. You can

also choose to view the play log of specific media or at certain time zone.

Click "Export” to export the viewing content to Excel file, as shown in Fig.15-11

9 Play Log
_3 |
4 |Play Date:2012-6-24 Make Time:2012/6/25 18:48:53
5 Name Duration Play Time Stop Time Result
] foreign_1. ipg 0:00:05 16:10:45 16:10:51 Succeed
7 girl. jpg 0:00:05 16:10:51 16:10:56 Succeed
8 zold. jpg 0:00:05 16:10:56 16:11:02 Succeed
9 gzirl. jpg 0:00:05 16:11:02 16:11:08 Succeed
10 foreign_1. ips 0:00:05 16:11:08 16:11:14 Succeed
11 zirl. jpg 0:00:05 16:11:14 16:11:19 Succeed
12 zold. jpg 0:00:05 16:11:19 16214225 Succeed
13 zirl. jpg 0:00:05 16:11:25 16:11:31 Succeed
14 foreign_l. ipg 0:00:05 16:12:43 16:12:49 Succeed
15 zirl. ipg 0:00:05 16:12:49 16:12:54 Succeed
16 zold. jpg 0:00:05 16:12:54 16:13:00 Succeed
17 zirl. jpg 0:00:05 16:13:00 16:13:06 Succeed
18
Fig.15-11 Play log form
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In the log statistics page, you can do statistics of the play times and failure times of media,

as shown in Fig.15-12.

Help  Language

Screen1 | Screen2 I

EENE] < » Q&

S M T W

1 2 3 4 5 6 7 - e
8 8 10 N 13 14 Log Path: C:Wsers\&dministratorDocuments'NovaStudio201 2L ogP l%’
15 16 17 18 19 20 21 S—

22 23 24 25 26 27 28

29 30 Current Log 2013-9-12
Date:
Choose the date in the left calendar for browwsing different log.
20131912 Clear
B @ =
(‘ZX] View Log | @8 Log Statistic
@ Al Media
) Specific Media Key Word: 4 ' :
cbiiolis oo [ T fiooow n | msiiam
‘ Name Played Time Succeed Time Failed Time
13 Text [ 5 0
‘Static text 5 5 0
Weather 5 5 0

Load log file:2013-9-12.plylog succeed!
Fig.15-12 Play log statistics

Click "Export” to export the statistics information to Excel file, as shown in Fig.15-13.

463}
5 Log Statistic
3
4 |Play Date:2012-6-24 Make Time:2012/6/25 18:58:16
5 Name Play Time Fail Time
6 foreign_1. ipz 3 0
7 girl. ipz 6 0
8 zold. ipz 3 0
qQ
Fig.15-13 Play log statistics form
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15.5 Backstage Media Playing
15.5.1Activate Backstage Media Playing

Following will take the OS of Windows XP as an example to illustrate how to active

backstage media playing.

Connect the computer video card DVI output interface with the DVI input interface of the
LED display control system. Right click on the desktop and select Properties form the pup

up menu, as shown in Fig.15-14

Arrange Icons By >
Refresh

Graphics Properties...

Graphics Options >
New »

Fig.15-14 Desktop properties

Select Setting page form the Display Properties dialog, as shown in Fig.15-15.

Phone: NovaStar (Xi’ an) 86-29-84507048 NovaStar (Shenzhen) 86-755-33592492

Website:www.novastar-led.com




NDVQSTAR NovaStar Tech Co.,Ltd

Display Properties

Theenes | Deskiop = Screen Saver  Appeatance Settngs
Diag the mordor scons 10 match the phyiscal attangeensnt of Your MONRONS

Display.
1. Dedault Morstoe on IntelR) G41 Express Chepset -
Scieen resohfon Color quality
Less 3 Mece HW (32 ba) R

1024 by 768 pixels [ 3R I e |

[ 1dentity || Troubleshoot. | [ Advanced |

| ok || cexe |

Fig.15-15 the Setting page

Select Monitor 2 and "“Extend my Windows desktop onto this monitor” , as shown in

Fig.15-16. Click OK when finish.

Display Properties

Themes | Desklop | Screen Saver | Appeaiance | Settngs
Drag the monitor icons to match the physical amangement of your mordors

Display:
| 2 [Defaukt Monkor) on IntelR) G41 Exprass Chipset v
Screen resobibon Color qualty

640 by 460 pecels 1 ' "= '=m

Fig.15-16 activate Monitor 2
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After the settings for Monitor 2, select Setting ->Backstage Playing from the main menu
of NovaStudio plus to apply backstage media playing. Note that media playing can not be
seen from the computer display when backstage media playing is applied. To check media

playing, select Setting ->Forestage Playing of NovaStudio plus. Reapply backstage

playing after checking.

15.5.2Cancel Backstage Media Playing

Cancel the selection of "Extend my Windows desktop onto this monitor” on the

Setting page of Display Properties dialog, and select Setting ->Forestage Playing of

NovaStudio plus.
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16 Notes and FAQ

16.1 Some conflicts between decoders may cause

media play error.

Do not install decoders or media players arbitrary. They may conflict with each other and
thus cause errors when NovaStudio plus is playing videos. NovaStudio plus V2.3 and later
will check if there is any known decoder that may cause conflict on the computer. And will
delete the decoder if allowed.

Please contact Nova if problems of decoder conflict are encountered.

16.2 Do not use low performance computers for

running NovaStudio plus.

Please use a computer meeting the requirements listed in the section of 1.2 Run
Environment of NovaStudio plus User Manual. The computer should have a higher
performance CPU and larger memory if NovaStudio plus is going to run on it with multiple
display windows. Note that the higher the computer performance is, the better the media

play results will be.

16.3 NovaStudio plus launch error due to the language

support of the operation system.

If the path of the NovaStudio plus.exe contains characters that are not belonged to the
default language of the operation system, it may not be able to launch. Messages as follow

may be shown.
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To solve this problem, please change the path and run again.

| Exception: The tppe initializer for Wova, Players MedialtermPlayer' threw an exception. ~
Syztem. TypelnitializationE sception
Stack Trace:
at Mova. Plaverz.MedialtemPlaver. GetlmageF romFile[Sting 0101, Boolean Q100101 |nk32
| ONOT000077, Ink32 000100107001, Imageé 011]

Fig.16-1 Error message

16.4 Unable to play files of Microsoft Word and Excel

Make sure Microsoft Word and Excel have been installed correctly, otherwise, NovaStudio
plus is not able to support files for Microsoft Word and Excel.
Please allow the operation if any firewall blocks the operation of adding Excel file. There no

virus risk as it is just Excel starting a library.

16.5 What to do if characters in a table of a Microsoft

Word file are slit?

Try a Microsoft Excel table.

16.6 Why NovaStudio plus does not run?

Please make sure that Microsoft.NET Framework 2.0 has been installed in the computer if
the error message in Fig.16-2 shows up when running NovaStudio plus. Microsoft.NET
Framework 2.0 is required for running NovaStudio plus.

Note that for Win8, Microsoft.NET Framework 3.5 is required. You can download it from

website www.novastar-led.com and then install. Or you can select corresponding option

when installing NovaStudio plus, Microsoft.NET Framework 3.5will be automatically

downloaded and installed after that.
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ovaStudio.exe - Application Error X

6 The application faded to inkiakze properly (0xc000013S). Click on OK to terminate the application.

Fig.16-2 Error message

16.7 Why Flash files cannot be added?

Make sure Flash OCX plug-in has been correctly installed. Copy install_flash_player_ax.exe

to the same folder of NovaStudio plus.exe and when performing installation.

16.8 Error message as below is shown when running

NovaStudio plus.

rroxr Notice @

Sorrys a fatal problem has occured!Please make sure the
correct operations You can restart the software to solwve this
problems

I hope you can help us to solwve this problem quickly:You can
choose "Send error report’ to send the error data to the
manufacturer or give the error report locating in the software
folder to the manufacturer, thank you?

imwerardste:| Sedierrorweport | weSoens Bt

E xception:Retrieving the COM class factory for component with CLSID {640FCCFE-1E23- A |
4108-A8D7-E3E4342D07CD} failed due to the following error: 8007007e. |
System. |0 FileNotF oundE xception
Stack Trace:

at NovaMini.FormMain. FrmM ain_Load(Object sender, Eventérgs &)

at System. Windows.Forms. Form. OnLoad(E ventbigs e)

at System.Windows. Forms. Form. OnCreateControl()

at System.Windows. Forms. Control CreateControl(B oolean fignoreVisible)

at System.Windows. Forms. Control. CreateControl()

at System. Windows. Forms. Control WmShowwWindow(Message&k m)

at System Windows. Forms.Control WndProc[Messaged m)

at System. Windows.Forms. ScrollableControl WndProc{Messageé m)

at System. Windows.Forms. ContainerControl WndProc{Message& m)

Fig.16-3 error message

Please contact us for technique support. And please click Send Error Report if internet is
available for the computer. If internet is not available, please click View Error Data and copy

all the data to a .txt file.
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16.9 Why NovaStudio plus can't load media sources
which it can before?
Select Help ->Reregister Decoder from the main menu of NovaStudio plus. Allow all

operations if they are blocked by OS or firewall.
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16.10 In IE6 environment, use the keyboard arrow
keys to move the display position of the web media

(do not use the mouse wheel).

16.11 Video Capture Card played instability in Win7,

please use Windows XP.

16.12 Please set the graphic card work under extend
monitor mode if the play window of the LED screen
is big in size. And please use advanced rendering
mode for video playback. Part of the play window

may be black if normal rendering mode is use.

16.13 Please use advanced rendering mode if text is
be put on top of video. There could be flashing on

the text if normal rendering mode is used.

16.14 Turn off Vertical Refresh Sync of the graphic
card when use NovaStudio plus for pictures
playback. Vertical Refresh Sync may cause influent

picture playback effects under Win7 and Win8.
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RADEON
GRAPHICS Catalyst Control Center
—_— Preferences
R« 3D Application Settings - 9

> Pinned J Configure system settings and manage user-defined application profiles for controlling the image quality and
5 Presets ‘ performance of 3D applications.
, Deskiop “ Feature Setting

Management © Anti-Aliasing =

Common Display 3

Tasks Application Setigs Anti-Aliasing Mode Use application settings

> My VGA Displays

Anti-Aliasing Samples Use application settings
> Video
Filter Box
v Gaming - - -
Anti-Aliasing Method Multisampling

Morphological Filtering Off |

> Performance

> Information ﬁ

v Texture Filtering

Anisotropic Filtering Mo...  Use application settings

m

Anisotropic Filtering Level  Use application settings
Texture Filtering Quality Standard

Surface Format Optimiza... On

~ Frame Rate Control

Wait for Vertical Refresh Always off

OpenGL Triple Buffering Off
v Tessellation

Tessellation Mode AMD optimized

Maximum Tessellation L.. ~ AMD optimized

Fig.16-4 Turn off Vertical Refresh Sync of the graphic card

16.15 For videos of format of .rmvb and those can
not be loaded by NovaStudio plus, please convert
the video format to mpeg4. Format converting tool

can be download from www.novastar-led.com .
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17 Document version statement

Version Date Update description
Software Version:
V2.2 2013-2-28
NovaStudio-V2.2.0
Software Version:
V2.4 2013-6-9
NovaStudio-V2.4.0
Software Version:
V2.6 2013-9-11
NovaStudio-V2.6.0
V2.7 2014-1-23 NovaStudio-V2.7.0
V3.0.0 2014-8-11 NovaStudio-V3.0.0
V310 2015-01-19 NovaStudio plus-V3.1.0
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